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Patents
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Notice to Customers
Contact your local dealer for technical assistance. To find the authorized dealer near you:

Hemisphere GNSS, Inc.

8444 N 90th St, Suite 120
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Phone: (480) 348-9919

Fax: (480) 348-6370
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Technical Support
If you need to contact Hemisphere GNSS Technical Support:
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Chapter 1: Introduction

What's In This Guide?
This user guide provides the following information to get you up and running quickly

with your Vector™ VS330™ GNSS compass.

. This chapter briefly describes the VS330 and the parts in your VS330 kit.

. Chapter 2, “Understanding the VS330"” discusses GPS and differential
operation as well as sensors and time constants related to the VS330.

o Chapter 3, “Installing the VS330” describes how to mount the antennas and
receiver, connect the cables, and power the system.

° Chapter 4, “Operating the VS330” provides instructions on configuring the
receiver, disabling aiding features, adjusting the time constants, and
operating the receiver.

. Appendix A, “Troubleshooting” provides possible solutions for issues.
. Appendix B, “FAQ" includes answer to common questions.
. Appendix C, “Menu Map” provides a full map of all system menus.

o Appendix D, “Technical Specifications” lists the technical specifications of
the VS330 and the included antennas.

Note: Throughout the rest of this user guide the Vector VS330 GNSS Compass is
referred to simply as the VS330.

Product Overview and Features

Based on Eclipse™ GNSS technology, the
VS330 (Figure ) is designed for precise marine
and land applications that require precise
heading and RTK position performance from Hemispnere)
the Vector VS330 GNSS compass. Featuring a
Hemisphere GPS Eclipse Vector-based receiver
and two separate antennas, VS330 achieves
heading accuracy ranging from 0.01° to 0.17°
rms (depending on the antenna separation) and
offers robust positioning performance.

With more accurate code phase measurements,
improved multipath mitigation, and fewer
components than competing products, VS330
offers superior accuracy and stability.

The VS330 receiver, with its display and user
interface, can be conveniently installed near the operator, while the two antennas are
mounted separately with a user-determined separation (up to 10 m) to meet the
desired accuracy.

VS330 uses L-band DGNSS(VBS/HP/XP/G2), SBAS (WAAS, EGNOS, MSAS, etc.), or
beacon for differential GPS positioning—offering differential positioning performance
of less than 0.5 m 95% of the time.

VS330 also features Hemisphere GPS’ exclusive COAST™ technology that enables
Hemisphere GPS receivers to utilize aging differential GPS correction data for 40
minutes or more without significantly affecting positioning quality. VS330 is less likely
to be affected by differential signal outages due to signal blockages, weak signals, or
interference when using COAST.

Vector VS330 GNSS Compass User Guide 2 PN 875-0323-000 Rev B1
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Key Features
Key features of the VS330 include:

. High-precision positioning in RTK, L1/L2, SBAS, beacon, and L-band (beacon
and L-band require an unlock code)

o Heave of 30 cm rms (DGPS), 10 cm (RTK)

. Pitch and roll < 1° rms

. Simple menu operations

. Accurate heading up to 3 minutes during GPS outages

. Integrated gyro and tilt sensors deliver fast startup times and provide
heading updates during temporary loss of GPS

What's Included in Your Kit

Your VS330 kit (Figure 1-1) includes the following parts:
. VS330 receiver and related mounting hardware

. Power and data cables

Note: The standard VS330 kit does not include antennas, antenna mounting
hardware, and antenna cables since receiver options vary.

Figure 1-1: VS330 system parts diagram

Table 1-1 on page 4 provides the description and part number of each part in your kit.

Review the parts shipped with your kit. If any parts are damaged, contact your freight
carrier. If any parts are missing, contact your dealer.

Vector VS330 GNSS Compass User Guide 3 PN 875-0323-000 Rev B1
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Table 1-1: Parts list

Item Part Name Qty Part Number

A VS330 receiver 1 803-3024-000#

B Receiver mounting kit 1 710-0056-000#
(two brackets and related hardware)

C Power cable, circular 1 054-0146-000#

D Data cable, DB-9 female to DB-9 male, 3 m 1 050-0011-022#

The following are available for purchase separately from the standard VS330 kit.

E Antenna (quantity of each based on your
purchased configuration)
A42 804-3045-000#
A43 804-3046-000#
A52 804-3038-000#
F Antenna mounting kit (quantity of each based on
your purchased configuration)
Ad2 710-0110-000#
A43 710-0111-000#
A52 710-0097-000#
Note: Your kit may not include a mag mount.
G Antenna cable, TNC male to TNC male, 5 m 2 052-0005-000#

Using VectorPC to Communicate with the
VS330

Hemisphere GPS’ VectorPC is a free utility program that runs on your Windows PC or
Windows mobile device. Simply connect your Windows device to the VS330 via the
COM port and open VectorPC. The screens within VectorPC allow you to easily
interface with the VS330 to:

Select the internal SBAS, beacon, or L-band correction source, if available,

and monitor reception

Configure GNSS message output and port settings

Review heading, pitch, and roll visually

Help calculate heading offset or heading bias

VectorPC is available for download from the OEM Software Downloads page on the
Hemisphere GPS website (www.hemispheregps.com).

Vector VS330 GNSS Compass User Guide 4
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GNSS Overview

For your convenience, the GNSS operation of the VS330 features automatic
operational algorithms. When powered for the first time, the VS330 performs a “cold
start,” which involves acquiring the available GNSS satellites in view and the SBAS
differential service.

If SBAS is not available in your area, an external source of RTCM SC-104 differential
corrections may be used. If you use an external source of correction data, it must
support an eight data bit, no parity, one stop bit configuration (8-N-1).

GNSS Operation

The GNSS receiver is always operating, regardless of the DGPS mode of operation.
The following sections describe the general operation of the VS330’s internal GNSS
receiver.

Note: Differential source and RTK status have no impact on heading, pitch, or roll.
They only have an impact on positioning and heave.

Automatic Tracking

The VS330's internal GPS receiver automatically searches for GNSS satellites,
acquires the signals, and manages the navigation information required for positioning
and tracking.

Receiver Performance

The VS330 works by finding four or more GNSS satellites in the visible sky. It uses
information from the satellites to compute a position within 2.5 m. Since there is
some error in the GNSS data calculations, the VS330 also tracks a differential
correction. The VS330 uses these corrections to improve its position accuracy to better
than 0.5 m.

There are two main aspects of GPS receiver performance:

. Satellite acquisition
. Positioning and heading calculation

When the VS330 is properly positioned, the satellites transmit coded information to
the antennas on a specific frequency. This allows the receiver to calculate a range to
each satellite from both antennas. GNSS is essentially a timing system. The ranges
are calculated by timing how long it takes for the signal to reach the GNSS antenna.
The GNSS receiver uses a complex algorithm incorporating satellite locations and
ranges to each satellite to calculate the geographic location and heading. Reception of
any four or more GNSS signals allows the receiver to compute three-dimensional
coordinates and a valid heading.

Differential Operation

The purpose of differential GPS (DGPS) is to remove the effects of selective
availability (SA), atmospheric errors, timing errors, and satellite orbit errors, while
enhancing system integrity.

Autonomous positioning capabilities of the VS330 will result in positioning accuracies
of 2.5 m 95% of the time. To improve positioning quality to sub-meter levels, the

Vector VS330 GNSS Compass User Guide 6 PN 875-0323-000 Rev B1
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VS330 is able to use differential corrections received through the internal SBAS
demodulator or externally-supplied RTCM corrections.

In addition to these differential services the VS330 can also receive radiobeacon
corrections. You can also purchase the VS330 with an RTK rover option, which enables
0.02 m positioning performance when paired with a suitable Hemisphere GPS RTK
base receiver product.

For more information on the differential services and the associated commands refer
to the Hemisphere GPS Technical Reference (go to www.hemispheregps.com and click
the GPS Reference icon).

Automatic SBAS Tracking

The VS330 automatically scans and tracks SBAS signals without the need to tune the
receiver. The VS330 features two-channel tracking that provides an enhanced ability to
maintain a lock on an SBAS satellite when more than one satellite is in view. This
redundant tracking approach results in more consistent tracking of an SBAS signal in
areas where signal blockage of a satellite is possible.

Beacon Operation

Many marine authorities, such as coast guards, have installed networks of
radiobeacons that broadcast DGPS corrections to users of this system. With the
increasing utility of these networks for terrestrial applications, there is an increasing
trend toward densification of these networks inland. The dual channel beacon receiver
in the VS330 can operate in manual or automatic tuning mode, or, using database
mode, will select the closest station in compliance with IEC 61108-4 standards.

RTK

Real time kinematic (RTK) technology is available on Eclipse-based GNSS receivers.
RTK requires the use of two separate receivers: a stationary base station (primary
receiver) that broadcasts corrections over a wireless link to the rover (secondary
receiver). The localized corrections are processed on the rover to achieve superior
accuracy and repeatability. Performance testing has shown positioning accuracy at
the centimeter level.

L-Band

L-band DGNSS (VBS/HP/XP/G2) corrections are available worldwide through third-
party providers. With this service, the positioning accuracy does not degrade as a
function of distance to a base station, as the data content is not composed of a single
base station’s information, but an entire network’s information.

Vector VS330 GNSS Compass User Guide 7 PN 875-0323-000 Rev B1
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VS330 Overview

The VS330 provides accurate and reliable heading and position information at high
update rates. To accomplish this task, the VS330 uses a high performance GNSS
receiver and two antennas for GNSS signal processing. One antenna is designated as
the primary GNSS antenna and the other is the secondary GNSS antenna. Positions
computed by the VS330 are referenced to the phase center of the primary GNSS
antenna. Heading data references the vector formed from the primary GNSS antenna
phase center to the secondary GNSS antenna phase center.

Fixed Baseline Moving Base Station RTK

The VS330's internal GNSS receiver uses both the L1/L2 GNSS C/A code and carrier
phase data to compute the location of the secondary GNSS antenna in relation to the
primary GNSS antenna with a very high sub-centimeter level of precision. The
technique of computing the location of the secondary GNSS antenna with respect to
the primary antenna, when the primary antenna is moving, is often referred to as
moving base station real time kinematic (or moving base station RTK).

Generally, RTK technology is very sophisticated and requires a significant number of
possible solutions to be analyzed where various combinations of integer numbers of
L1/L2 wavelengths to each satellite intersect within a certain search volume. The
integer number of wavelengths is often referred to as the “ambiguity” as they are
initially ambiguous at the start of the RTK solution.

The VS330 restricts the RTK solution by knowing that the secondary GNSS antenna is
a fixed distance from the primary GNSS antenna. The default value is 1.0 m, but you
may install the antennas with a different separation distance, then enter that value
into the VS330. This is called a fixed baseline and it defines the search volume of the
secondary antenna as the surface of a sphere with radius 1.0 m centered on the
location of the primary antenna (see Figure 2-1).

Primary antenna

| m |

| I1.0 m baseline |
Figure 2-1: Secondary antenna’s search volume
Note: The VS330 moving base station algorithm only uses GNSS to calculate

heading. Differential and RTK corrections are not used in this calculation and will not
affect heading accuracy.
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GLONASS

The VS330 is available in its base form as L1/L2 GPS. By adding GLONASS the
number of available satellites increases. thereby improving the ability to obtain and
maintain a heading solution. For a heading calculation, GPS and GLONASS satellites
are used interchangeably, as intersystem biases cancel inside the VS330—this
translates into being able to work in more obstructed areas and maintain a GNSS
heading solution.

L2 Advantages

Compared to Hemisphere GPS’ Crescent Vector technology, Eclipse Vector’s dual
frequency technology allows for:

. Larger antenna separations
. Longer range RTK
. Faster and more robustly computed GNSS heading solution

Supplemental Sensors

The VS330 has an integrated gyro and two tilt sensors, which are enabled by default.
Each supplemental sensor may be individually enabled or disabled. Both
supplemental sensors are mounted on the printed circuit board inside the VS330.

The sensors act to reduce the RTK search volume, which improves heading startup
and reacquisition times. This improves the reliability and accuracy of selecting the
correct heading solution by eliminating other possible, erroneous solutions.

The Hemisphere GPS Technical Reference (go to www.hemispheregps.com and click
the GPS Reference icon) describes the commands and methodology required to
recalibrate, query, or change the sensors status.

Tilt Aiding

The VS330's accelerometers (internal tilt sensors) are factory calibrated and enabled
by default. This constrains the RTK heading solution beyond the volume associated
with just a fixed antenna separation. This is because the VS330 knows the
approximate inclination of the secondary antenna with respect to the primary
antenna. The search space defined by the tilt sensor will be reduced to a horizontal
ring on the sphere’s surface by reducing the search volume. This considerably
decreases startup and reacquisition times (see Figure 2-2).

Tilt angle

Figure 2-2: VS330's tilt aiding
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Gyro Aiding

The VS330's internal gyro offers several benefits. It reduces the sensor volume for an
RTK solution. This shortens reacquisition times when a GPS heading is lost because
the satellite signals were blocked. The gyro provides a relative change in angle since
the last computed heading, and, when used in conjunction with the tilt sensor, defines
the search space as a wedge-shaped location (see Figure 2-3).

Figure 2-3: VS330’s gyro aiding

The gyro aiding accurately smoothes the heading output and the rate of turn. It
provides an accurate substitute heading for a short period depending on the roll and
pitch of the vessel, ideally seeing the system through to reacquisition. The gyro
provides an alternate source of heading, accurate to within 1° per minute for up to
three minutes, in times of GPS loss for either antenna. If the outage lasts longer than
three minutes, the gyro will have drifted too far and the VS330 begins outputting null
fields in the heading output messages. There is no user control over the timeout
period of the gyro.

The gyro initializes itself at powerup and during initialization, or you can calibrate it as
outlined in the Hemisphere GPS Technical Reference (go to www.hemispheregps.com
and click the GPS Reference icon). When the gyro is first initializing, it is important that
the dynamics that the gyro experiences during this warmup period are similar to the
regular operating dynamics. For example, if you use the VS330 on a high speed,
maneuverable craft, it is essential that when gyro aiding in the VS330 is first turned
on, use it in an environment that has high dynamics for the first five to ten minutes
instead of sitting stationary.

With the gyro enabled, the gyro is also used to update the post HTAU smoothed
heading output from the moving base station RTK GPS heading computation. This
means that if the HTAU value is increased while gyro aiding is enabled, there will be
little to no lag in heading output due to vehicle maneuvers. The Hemisphere GPS
Technical Reference includes information on setting an appropriate HTAU value for the
application.

Time Constants

The VS330 incorporates user-configurable time constants that can provide a degree of
smoothing to the heading, pitch, rate of turn (ROT), course over ground (COG), and
speed measurements. You can adjust these parameters depending on the expected
dynamics of the vessel. For example, increasing the time is reasonable if the vessel is
very large and is not able to turn quickly or would not pitch quickly. The resulting
values would have reduced “noise,” resulting in consistent values with time. However,
if the vessel is quick and nimble, increasing this value can create a lag in
measurements. Formulas for determining the level of smoothing are located in the

Vector VS330 GNSS Compass User Guide 10 PN 875-0323-000 Rev B1
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Hemisphere GPS Technical Reference (go to www.hemispheregps.com and click the
GPS Reference icon). If you are unsure on how to set this value, it is best to be
conservative and leave it at the default setting.

Heading Time Constant

Use the $JATT,HTAU command to adjust the level of responsiveness of the true
heading measurement provided in the $GPHDT message. The default value of this
constant is 0.1 seconds of smoothing when the gyro is enabled. The gyro is enabled
by default, but can be turned off. By turning the gyro off, the equivalent default value
of the heading time constant would be 0.5 seconds of smoothing. This is not
automatically done and therefore you must manually enter it. Increasing the time
constant increases the level of heading smoothing and increases lag.

Pitch Time Constant

Use the $JATT,PTAU command to adjust the level of responsiveness of the pitch
measurement provided in the $PSAT,HPR message. The default value of this constant
is 0.5 seconds of smoothing. Increasing the time constant increases the level of pitch
smoothing and increases lag.

Rate of Turn (ROT) Time Constant

Use the $JATT,HRTAU command to adjust the level of responsiveness of the ROT
measurement provided in the $GPROT message. The default value of this constant is
2.0 seconds of smoothing. Increasing the time constant increases the level of ROT
smoothing.

Course Over Ground (COG) Time Constant

Use the $JATT,COGTAU command to adjust the level of responsiveness of the COG
measurement provided in the $GPVTG message. The default value of this constant is
0.0 seconds of smoothing. Increasing the time constant increases the level of COG
smoothing. COG is computed using only the primary GPS antenna and its accuracy
depends upon the speed of the vessel (noise is proportional to 1/speed). This value is
invalid when the vessel is stationary.

Speed Time Constant

Use the $JATT,SPDTAU command to adjust the level of responsiveness of the speed
measurement provided in the $GPVTG message. The default value of this parameter
is 0.0 seconds of smoothing. Increasing the time constant increases the level of speed
measurement smoothing.

Vector VS330 GNSS Compass User Guide 1 PN 875-0323-000 Rev B1
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Mounting the Antennas

Hemisphere GPS recommends mounting the antennas first then the mounting the
receiver. When mounting the antennas consider the following:

. Mounting orientation (parallel or perpendicular)

. Proper antenna placement

o Mounting options (magnetic, pole, or rail mounting)

Antenna Options

The standard VS330 kit does not include antennas. Your VS330 kit may contain a
combination of the following antennas: A42, A43, and/or A52. For example:

. If you will be using beacon, your kit may include one A43 beacon antenna
and one A42 antenna (or one A43 and one A52).

. If you will not be using beacon, your kit may include two A42 antennas or
two Ab2 antennas.

Mounting Orientation

The VS330 outputs heading, pitch, and roll readings regardless of the orientation of
the antennas. However, the relation of the antennas to the boat’s axis determines
whether you will need to enter a heading, pitch, or roll bias. The primary antenna is
used for positioning and the primary and secondary antennas, working in
conjunction, output heading, pitch, and roll values.

Regardless of which mounting orientation you use, the VS330 provides the ability to
output the heave of the vessel. This output is available via the $GPHEV message. For
more information on this message refer to the Hemisphere GPS Technical Reference
(go to www.hemispheregps.com and click the GPS Reference icon).

Parallel Orientation

The most common installation is to orient the antennas parallel to, and along the
centerline of, the axis of the boat. This provides a true heading. In this orientation:

. If you use a gyrocompass, you can enter a heading bias in the VS330 to
calibrate the physical heading to the true heading of the vessel.

. You may need to adjust the pitch/roll output to calibrate the measurement if
the Vector is not installed in a horizontal plane.

Perpendicular Orientation

You can also install the antennas so they are oriented perpendicular to the centerline
of the boat’s axis. In this orientation:

. You will need to enter a heading bias of +90° if the primary antenna is on the
starboard side of the boat and -90° if the primary antenna is on the port side
of the boat.

. You will need to configure the receiver to specify the GPS antennas are
measuring the roll axis using $JATT,ROLL,YES.

. You will need to enter a roll bias to properly output the pitch and roll values.

o You may need to adjust the pitch/roll output to calibrate the measurement if
the Vector is not installed in a horizontal plane.

Vector VS330 GNSS Compass User Guide 14 PN 875-0323-000 Rev B1
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Planning the Optimal Antenna Placement

Note: In the VS330 kit, install the A42 or A52 antenna as the primary antenna as it is
used for positioning.

Proper antenna placement is critical to positioning accuracy. For the best results,
orient the antennas so the antennas’ connectors face the same direction. Also, place
the antennas:

. With a clear view of the horizon

e  Away from other electronics and antennas

. Along the vessel’s centerline

YNWAGLIINER  You must install the primary antenna along the vessel’s
centerline; you cannot adjust the position readings if the primary antenna is
installed off the centerline. Positions are computed for the primary antenna.

. On a level plane

. With a 10.0 m maximum separation (default is 1.0 m)
e  Away from radio frequencies

. As high as possible

Set the MSEP value to be accurate to within 1 to 2 cm. For more information on MSEP
refer to the Hemisphere GPS Technical Reference (go to www.hemispheregps.com
and click the GPS Reference icon).

See Figure 3-1 below through Figure 3-3 on page 16 for mounting orientation
examples.

P = primary antenna (A42 or A52) +P
Forward
S = secondary antenna (A42, A52, or A43%) 4/ motion
*must be A43 if using beacon /
S
-H
Receiver I +H
(display must :
face primary ;
antenna) L .
Antenna
<. separation

(1.0 m default,
10.0 m maximum)

Figure 3-1: Recommended orientation and resulting signs of HPR values
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P = primary antenna (A42 or A52)

S = secondary antenna (A42, A2, or A43%) 7
*must be A43 if using beacon

Receiver
(display must
face primary o~ .
antenna) / TS
b Antenna

Forward P

motion

separation
(1.0 m default,
10.0 m maximum

;

Figure 3-2: Alternate orientation and resulting signs of HPR values

T

Centerline

Figure 3-3: Antenna installation: Cross-section of boat

Mounting Options

You can mount the antennas with a magnetic mount, pole mount, or rail mount
configuration. You can secure the antennas to a threaded pole or threaded mount
using the included mounting adapters.

Depending on the antennas included in your kit, you may need to use the included
antenna height adapters to bring the antennas level. If the adapter is not used, you
will need to enter a non-level bias calculation into the system (see “Q: | could not
install my antennas at the same height. How do | calibrate for the height offset?” on
page 47 of Appendix B, “FAQ.")

YNWAGLIINER The maximum allowable antenna separation is 10.0 m. Any greater
distance may result in an incorrect heading.
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Magnetic Mount

The following procedure assumes your kit contains one A43 beacon antenna and one
A42 antenna. If your kit contains an A52 antenna instead of an A42, follow the same
steps. If your kit does not contain an A43 beacon antenna, mount both antennas in the
same manner as outlined in the steps for the A42.

Note: Your kit may not include a magnetic mount.

You can screw the magnetic mount into the bottom of the antenna and mount it to any
metal surface. If there are no metal surfaces, use the zinc disc and foam adhesive
included in your kit to mount the antenna.

To mount the antennas using the magnetic mount:

1. Select a location and orientation that meet the
requirements outlined in “Mounting Orientation”
on page 14 and “Planning the Optimal Antenna
Placement” on page 15.

2.  A42 antenna only: Unlike the A43, the A42
antenna does not include a threaded mounting
hole. You must attach the mounting bracket (see at
right) using the four screws in your kit.

3. Attach the magnetic mount extension to the
magnetic base plate.

Note: Photos at right and in
step 4 show the zinc disc
attached to the magnetic base
plate. You will only need the
zinc disc if mounting the
antenna to a non-metal surface
(see steps 6 through 11).

4. Thread the magnetic mount into the mounting bracket on the bottom of the
A42 or A52 antenna or into the bottom of the A43 antenna.

VNILGLUNEH When threading the magnetic mounts, hand tighten only.
Damage resulting from over-tightening may void your warranty.

il

If you are mounting the antenna on a metal surface, go to step 5.

If you are mounting the antenna on a non-metal surface and need to use the
metal disc and foam adhesive, skip step 5 and complete steps 6 through 11.
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5. Place the antenna in the desired location, ensuring the antenna is secure in
its mounting position (end of metal surface mounting procedure).

Clean and dry the surface where you will attach the zinc disc.

Remove the backing from one side of the
foam adhesive and press the adhesive
onto the zinc plate (at right).

8. Remove the backing from the other side
of the foam adhesive and press the zinc
disc onto the mounting surface on the
vessel, applying firm pressure to ensure good adhesion.

9. Place the antenna on top of the zinc disc, ensuring the antenna is secure in
its mounting position.

Pole Mount

The following procedure assumes your kit contains one A43 beacon antenna and one
A42 antenna. If your kit contains an A52 antenna instead of an A42, follow the same
steps. If your kit does not contain an A43 beacon antenna, mount both antennas in the
same manner as outlined in the steps for the A42.

You can pole-mount the antennas using existing hardware on your vessel.
To mount the antennas using a pole mount:

1.  Select a location and orientation that meet the
requirements outlined in “Mounting Orientation”
on page 14 and “Planning the Optimal Antenna
Placement” on page 15.

2.  A42 antenna only: Unlike the A43, the A42
antenna does not include a threaded mounting
hole. You must attach the mounting base using the
four screws included in your kit (see at right).

3. Thread the pole mount (not included) into the
mounting bracket on the bottom of the A42
antenna or into the bottom of the A43 antenna.

YNWAGLIINER When threading the pole mounts, hand tighten only. Damage
resulting from over-tightening may void your warranty.

4. Mark and drill any mounting holes necessary for the pole mounts.

Vector VS330 GNSS Compass User Guide 18 PN 875-0323-000 Rev B1



Chapter 3: Installing the VS330

Rail Mount
You can rail mount the antennas using existing hardware on your vessel.
To rail mount the antennas:

1.  Select a location and orientation that meet the requirements listed in
“Mounting Orientation” on page 14 and “Planning the Optimal Antenna
Placement” on page 15.

2. Use appropriate hardware to securely attach the antenna to the railing.

Routing and Securing the Antenna Cable

YNWLGLIIN R The VS330 receiver provides 5 VDC across the antenna ports.
Connection to incompatible devices may damage equipment.

To route and secure the antenna cables, review the following guidelines. Each antenna
in your kit requires a 50 Q impedance antenna extension cable, such as RG-58U (up to
a maximum of 15 m (49 ft.) in length), for proper operation.

. The GPS receiver inside the VS330 requires a minimum input gain of 10 dB
(and maximum of 40 dB before saturation will occur). The antennas offer
28 dB of gain, so the loss budget to accommodate for cable losses is 18 dB.

. Regardless of the cable material and length you choose, ensure the cable
losses are less than 18 dB of attenuation. Due to variances in the antenna
gain and practical attenuation of cable materials and connectors,
Hemisphere GPS recommends reducing this budget to 15 dB; this budget is
present to overcome the resulting attenuation of an RF cable.

. When deciding on an antenna location, consider the amount of cable
required: a longer cable of the same material will result in a higher loss than
a shorter one. If the overall loss of the longer cable exceeds 15 dB, change
the cable material (this normally means a more expensive material that has
a larger diameter and less flexibility). The standard cables included with the
VS330 are of the RG58 material family and their attenuation is ~0.8 dB/m.
Including connector losses, the nominal loss of these RF cables is ~10 dB,
which is within the tolerable loss budget. If a 15 m or 20 m cable run is
required, a RG8 variety is available. If lengths longer than 20 m are required,
more sophisticated materials are required.

For more information on cable length or low-loss cable, contact your dealer or
Hemisphere GPS Technical Support. Table 3-1 provides a summary of readily available
cable materials with 50 Q impedance.

Table 3-1: Cable losses (not including connector losses)

Material Loss at GPS L1 (1.575 GHz)
RG58 0.78 dB/m
RG8 0.36 dB/m
Times Microwave LMR400 0.15 dB/m

For additional cable guidelines see “Routing and Connecting the Cables” on page 21.
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Mounting the Receiver

Hemisphere GPS recommends mounting the antennas first and then the mounting

the receiver. Use the enclosed kit to mount the receiver. When mounting the VS330
receiver, adhere to the following guidelines:

. Install the receiver inside and away from the elements and in a location that

minimizes vibration, shock, extreme temperatures, and moisture
Position the receiver horizontally with its display facing the primary antenna
Ensure the front panel (menu screen, LEDs, buttons) is visible and accessible

Ensure the back panel (ports, connectors) is easily accessible to connect/
switch out cables

Figure 3-4 shows the dimensions (including attached mounting brackets) of the
VS330. Use Figure 3-4 when using the receiver mounting procedure that follows.

gﬁm_gé:g: 52mm
= = ’//ﬁ"4xomm
1346 mm 1143 mm
5.30in 450in
141.6 mm
\ 5.57in

2014 mm
793in

7a9mm || —>
295in e (O @ y—
I

* . 1143mm ‘ ‘
450in
1524 mm
600in

Figure 3-4: VS330 dimensions with mounting brackets

To mount the receiver:

Locate the thumbscrews, nuts, and brackets included in your kit.

2. Slide the nuts through the
opening (circled at right) along
both sides of the receiver.

Hemisphere
=L
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Place the bracket alongside the
receiver and insert the
thumbscrews (two
thumbscrews per bracket) so
they screw into the nuts.

Hemisphere
aeey

Using the remaining holes in Remaining bracket holes

the brackets (two holes per

bracket) screw down the /—\
brackets in your preferred

location.

Note: Hemisphere GPS does
not provide the screws in
this step.

\/

Remaining bracket holes

Routing and Connecting the Cables

Adhere to the following when routing and connecting cables:

Power cable must reach an appropriate power source
Antenna cables must reach from the antennas to the receiver

Data cable may connect to a data storage device, computer, or other device
that accepts GNSS data

Do not run cable in areas of excessive heat

Do not expose cable to corrosive chemicals

Do not crimp or excessively bend cable

Do not place tension on cable

Coil up excess cable near unit

Secure along the cable route using plastic tie wraps as necessary

Do not run cable near high voltage or strong RF noise and transmitter
sources

When connecting the power cable to the power source, ensure the power
source is between 8 V and 36 V

YWILGUUINEH Improperly installed cables near machinery can be dangerous.
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Connecting the Receiver to External Devices

You can connect the VS330 to external devices via Port A and Port B on the back of the
unit.

POWER

e B °

PRIMARY RF SECONDARY RF

Q@ °E.

)

PORT A

Figure 3-5: VS330 port connections

Figure 3-6 shows the pinout for Port A (ODU 9-pin) and Port B (DB9), and Table 3-2
provides descriptions of the pinouts for each port. Both ports communicate at the
RS-232 interface level with external data loggers, navigation systems, and other
devices, while Port A can also transmit at the RS-422 level.

The default baud rates, NMEA message types, and update rates for both ports are
listed in “Default Parameters” on page 24. If the NMEA data messages you desire are
different from the default values, you will need to select those also. Use the Config
Wizard to select your NMEA message types and update rates per port (see “Using the
Config Wizard” on page 31).

Table 3-2: Port A / Port B pinout descriptions

Pin Port A Port B
1 Port A Rx (RS-232) Not connected
2 Signal ground Port B Tx
(RS-232)
3 Signal ground Port B Rx
(RS-232)
4 1 PPS timing output | Not connected
5 Port A Tx+ Signal ground
(RS-422)
6 Port A Tx- Not connected
(RS-422)
7 Event marker input | Not connected
Figure 3-6: Port A (top) and 8 Port A Tx (RS-232) Not connected
Port B (bottom) pinouts 9 Reserved 5V output, 350 mA
max
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Figure 3-7 shows the I/O cable that connects to Port A.

«——— 1.016M ———p |: 20m >

J1 EMITC L

(connects to
Port A on receiver)

Figure 3-7: I/O cable
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Default Parameters

The following represents the standard configuration for the VS330. For more
information on these commands refer to the Hemisphere GPS Technical Reference (go
to www.hemispheregps.com and click the GPS Reference icon).

Note: Use the $JSAVE command to save changes you make to the VS330
configuration for the changes to be present in subsequent power cycles. Also, if you
change any default values and then issue a $JRESET command verify your settings
to make sure you consistently get a correct heading. To reset the VS330 to its default
parameters you can re-install the configuration file (shown below)—contact your
dealer or Hemisphere GPS Technical Support for information on obtaining and
re-installing the configuration file.

$JOFF, PORTA
SJOFF, PORTB
$JOFF, PORTD

$JAGE, 2700
$JLIMIT, 10
$JMASK, 5

$JNP, 5
$JWAASPRN, AUTO
$JIDIFF, WAAS
$JP0S,51.0,-114.0
$JSMOOTH, LONG
$JTAU, COG, 0.00
$JTAU, SPEED, 0.00
$JAIR, AUTO
$JALT, NEVER

$JATT,ACC180, YES
$JRELAY, PORTC, SMENUOPTIONS, ACC180, ON, TRUE
$JATT, HTAU, 0.1
$JATT, HRTAU, 2.0
$JATT, COGTAU, 0.0
$JATT,MSEP, 1.0
$JATT, GYROAID, YES
$JATT, TILTAID, YES
$JATT, LEVEL, NO
$JATT, EXACT, NO
$JATT, HIGHMP, YES
$JATT, FLIPBRD, YES
$JATT, HBIAS, 0.0
$JATT, NEGTILT, NO
$JATT, NMEAHE, 0
$JATT, PBIAS, 0.0
$JATT, PTAU, 0.5
$JATT, ROLL, NO
$JATT, SPDTAU, 0.0
$JASC, ROX, 0, PORTD

$JBAUD, 19200, PORTA
$JASC, GPGGA, 1, PORTA
$JASC, GPHDT, 10, PORTA
$JASC, GPROT, 10, PORTA
$JASC, GPHPR, 1, PORTA

$JBAUD, 19200, PORTB

$JASC, GPGGA, 1, PORTB
$JASC, GPHDT, 10, PORTB
$JASC, GPROT, 10, PORTB
$JASC, GPHPR, 1, PORTB

$JSAVE
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Powering the Receiver On/Off

LED Indicators
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Adjusting the Time Constants

Connecting to Existing Navigation Systems
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Powering the Receiver On/Off

The power button on the VS330 is located on the front panel (circled below). When
you first apply power to the unit it turns on.

(50}
VECTOR VS330

Figure 4-1: VS330 front panel with power button

The VS330 accepts an input voltage of 8 to 36 VDC via the power cable. The supplied
power should be continuous and clean for best performance. Table D-5 on page 59
provides the power specifications of the VS330.

yN\WAGLIINER Do not apply a voltage higher than 36 VDC. This will damage the
receiver and void the warranty. Also, do not attempt to operate the VS330 with the
fuse bypassed as this will void the warranty.

The VS330 features reverse polarity protection to prevent damage if the power leads
are accidentally reversed. Although the VS330 proceeds through an internal startup
sequence when you apply power, it will be ready to communicate immediately.

Initial startup may take 5 to 15 minutes depending on the location. Subsequent
startups will output a valid position within 1 to 5 minutes depending on the location
and time since the last startup.

The VS330 may take up to 5 minutes to receive a full ionospheric map from SBAS.
Optimum accuracy is obtained once the VS330 is processing corrected positions using
complete ionospheric information.

To power on the VS330:
1. Connect the ends of the VS330 power cable to a clean power source
providing 8 to 36 VDC.

Note: Hemisphere GPS recommends you use a weather-tight connection
and connector if the connection is located outside.

2. Press and hold the soft power switch on the front panel until the splash
screen appears.
To power off the VS330:

. Press and hold the soft power switch on the front panel until the screen goes
blank.
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LED Indicators

The VS330 includes five LEDs located to the left of the

display on the front panel (shown at right). HEADING =

Table 4-1 below describes each LED indicator. DIFF (&

SEC GPS &

PRIM GPS &

POWER (%

Figure 4-2: VS330 LEDs

Table 4-1: LED indicators

Indicator

Description/Function

HEADING

Valid GNSS heading available

Illuminates solid green when the receiver achieves a valid heading
solution from the GNSS receiver. You must see PRIM GPS and SEC GPS
illuminated before a heading solution is possible.

If the GNSS solution is no longer available, the LED turns off.

DIFF

DGPS position indicator
llluminates solid green when the receiver achieves a differential position
and a pseudorange residual of better than 10.0 m.

If the residual value is worse than the current threshold, the LED blinks
green indicating differential mode has been attained but the residual has
not met the threshold.

SEC GPS

Secondary antenna is tracking 4 or more satellites

Illuminates solid amber when the secondary antenna is tracking four or
more satellites.

PRIM GPS

Primary antenna is tracking 4 or more satellites

Illuminates solid amber when the primary antenna is tracking four or
more satellites.

POWER

Power indicator

llluminates solid red when the receiver is powered on.
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Startup

When you power on the VS330 the Hemisphere
GPS splash screen appears followed by the main
screen, or Top menu (see at top right). Press the
Down Arrow button to display the remaining items
on the Top menu (see at bottom right).

You use the menus to view and configure system
data and settings for the following Top menu

items:

Vector
GNSS

Differential (menu item will be the
selected differential source, such as
SBAS or Autonomous)

Config Wizard
System Setup
Data Logging

For a complete menu path of each Top menu item,
see Appendix C, “Menu Map.”

I'II.I.'[[I_Z&ZSﬁS

Vector)p

GNSS)

Diff SBAS)

NN LN 22:25:53

Config Wizard )

System Setup)

Data Logging )
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Using the Menus

The VS330 menu system is designed for
easy setup and configuration of the unit in
or out of the field and supports multiple
languages. You can perform most
configuration tasks entirely through the
menu without having to connect to a
computer.

The VS330 front panel contains the three
soft buttons shown at right. The Enter
button also functions as the power switch
(see “Powering the Receiver On/Off” on
page 26 for more information).

Table 4-2 describes the indicators to the
right of specific menu items.

Table 4-2: Menu item indicators

Up Arrow button - moves to
the previous menu item or to
the previous selection within
a menu item

Enter button - displays a
submenu or selects an option
within a menu item

Down Arrow button - moves
to the next menu item or to
the next selection within a
menu item

e  Press Enter when
“Back” is selected to
return to the previous
menu.

e Press Enter when “Top
Menu” is selected to
return to the Top menu.

Scrolls within a menu to
highlight an option to select.

Select
indicator

Indicator Purpose Example
Goes to the indicated 1. On the Top menu press the Down
submenu. Arrow button to highlight System
This indicator also appears Setup. The Display indicator appears to
to the right of the “Back” the right of System Setup.
Displa and “Top Menu” menu 2. Press Enter to display the System Setup
. p Y items. menu.
indicator

3. Press the Down Arrow button again to
highlight the Display Format option and
then press Enter. The items on the
Display Format menu appear and the
Select indicator appears to the right of
Disp Update (the first item on the
Display Format menu).

4. Press Enter on the Disp Update item.
The Display indicator changes to the
Select indicator.

5. Press the Up Arrow or Down Arrow
button to scroll through the available
options (such as 1Hz and 5Hz).

6. Press Enter on the highlighted option to
select it. That option is now the setting
for the menu item and the Select
indicator changes back to the Display
indicator.

To return the menu system to the factory default configuration:

o Press and hold the Enter and Up Arrow buttons until the splash screen
disappears (Enter and Power share the same soft switch).
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Configuring the VS330

The Config Wizard menu guides you through various configuration options, enabling
you to save up to five different configurations that are useful when using the VS330
on different vessels or for different applications.

If you use a Windows PC or Windows mobile device, you can use Hemisphere GPS’
VectorPC software to configure the VS330. See “Using VectorPC to Communicate with
the VS330” on page 4 for more information.

Config Wizard Menu

This section describes the basic Config Wizard options you need to set to get up and
running. Figure 4-3 outlines the menu structure of the Config Wizard menu.

GPGGA > Off
GPGLL > Off
GPGNS > Off
GNGNS > Off
GPGSA > Off
GNGSA > Off
GPGST > Off
GPGSV > Off
GLGSV > Off
GPHDT > Off
GPHEV > Off
Vector > Proceed Wizard > - Create New > — > Enter Name > A gi:ﬂk i g::
GNSS > Delete Saved > Save Current > Diff > SBAS GPRMC > Off
Differential > Use Previous > Back > Data PORT A > GPROT > Off
Config Wizard >+ Cancel > Top Menu > Data PORT B >
GPRRE > Off
System Setup > Elev Mask > 5 Tss1 > Off
Data Logging > MaxDGPSAge > 3600
PORT A > 9600 GEVIG > Off
GPZDA > Off
PORT B > 9600 Binl > Off
Aiding Features > Ly ::zz ; gg
Time Constants > B
3 q Bin65 > Off
Bias, Neg, Tilt > .
Biné66 > Off
Ant. Sep > 1.000m 3
5 N Bin69 > Off
L b Pitch/Roll > Pitch Bin76 > Off
A A Save to Location > — B
Lt 51°00.131035' HTAU > 0.5 Back > BinSORE>H0LL
Ln 114°00.273158" HRTAU > 0.0 Top Menu > Bin89 > Off
Hgt 1030.400 m coc > 0.0 B:}n94 > Off
Set Reference SPEED > 0.5 Bin85 > off
PTAU > 0.0 Bin96 > Off
Back > Bin97 > Off
Top Menu > Save to Location > Bin98 > Off
Not Usedl > Bin99 > Off
Not Used2 > Binl00 > Off
h 4 v Not Used3 > RD1 > Off
Gyroaid > YES Heading > 0.0 Not Usedd > PCSI,1 > Off
Tiltaid > YES Pitch/Roll > 0.0 Not Used5 > RTCMv3 > Off
Back > Neg Tilt > NO CMR > Off
Top Menu > Level Op. > YES ROX > Off
Back > DFX > Off
Top Menu > Back >

Figure 4-3: Config Wizard menu
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Using the Config Wizard
The basic setup instructions outlined in this section assume the antennas are:

. Installed parallel to, and along the centerline of, the vessel’s axis
o Separated by 1.0 m

If this is not the case, you will need to enter the actual antenna separation and bias in
the Config Wizard.

1.  Select Config Wizard > Proceed Wizard. The Proceed Wizard menu
appears.

2. Select Create New to create a new configuration.
Yo ted to enter a name for your Enter Name > A
ou are prompte = Y Diff > SBAS
configuration. In addition to the Name youcanset | pata porT 2 >

the options shown at right (also shown in Data PORT B >
Figure 4-3 on the previous page). Elev Mask > 5
MaxDGPSAge > 3600
Note: For help on using the menus to view and PORT A > 9600
setting values see “Using the Menus” on EOER 1D > D0y
Reference
page 29.

Aiding Features >
Time Constants >
3. Enter a name: Bias, Neg, Tilt >

a. Use the arrow buttons to select a character Haig, S > L. 0UEn
Pitch/Roll > Pitch

and then press the Enter button to save the < :
. ave to Location >
character. The cursor moves to the right. Back >

b. Repeat step a for each additional character in Top Menu >
the name.

c. Scroll through the list of characters until you reach “."” and press the
Enter button to accept the name. You are returned to the previous
menu and the name you entered appears next to “Enter Name.”

If you are editing an existing name, for characters you want to replace
simply select a different character. If the new name is shorter and you need
to delete unneeded characters to the right:

a. After you change the final character in the new name press the Enter
button repeatedly until the last character is highlighted.

b. Scroll through the list of characters until you reach “4"” and press the
Enter button to delete the character. The cursor moves to the left.

c. Repeat step b for each additional rightmost character you want to
delete.

d. Scroll through the list of characters until you reach “.J” and press the
Enter button to accept the name. You are returned to the previous
menu and the name you entered appears next to “Enter Name.”

4. Set a DGPS source: From the same menu, select DIFF. The options are:

SBAS (default)

Beacon

Autonomous

RTK

L-Band

Extern RTCM (External RTCM)
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10.

1.

12.

13.

14.

15.

Change the type of GPS data message sent to the data ports: Select either
Data Port A or Data Port B from the menu list.

Set the elevation cutoff angle: Select Elev Mask and set the angle between
0° and 45°. The default value is 5°.

Set the maximum DGPS age: The maximum DGPS age is 2700 seconds (45
minutes) by default.

Configure baud rates: If the default baud rate on the selected port does not
match that of the external device you are connecting to, you will need to
configure the Baud Rate, using the Port A or Port B entries.

4800, 9600, 19200, 38400, 57600, and 115200 are the available baud rates.

Enable/disable aiding features: The Aiding Features menu enables you to
turn the gyroaid and tiltaid features on or off. For more information on
disabling the aiding features, see “Disabling Tilt Aiding” on page 33 or
“Disabling Gyro Aiding” on page 33.

Adjust time constants: While the default time constants settings will work for
most users, if you have a large, slow turning vessel or a small, quick moving
vessel you may want to adjust the time constants to reduce heading start up
and re acquisition times.

For details on configuring the time constants, see “Adjusting the Time
Constants” on page 34.

Enter a heading bias: If you did not install the antenna’s parallel to and along
the vessel'’s centerline, you will need to enter a heading bias in the Heading
field of the Bias, Neg, Tilt menu. The heading bias (-180° to +180°)
compensates for any offset from the centerline.

Note: If you installed the antennas for roll (perpendicular to the boat’s
axis), rather than pitch, you must enter the heading bias (+/-90°). You must
also enter the bias for roll (see below).

Enter a pitch/roll bias: Enter the bias for pitch or roll (-15° - +15°) to
compensate for any offset from the boat’s centerline. Enter this bias in the
Pitch/Roll field of the Bias, Neg, Tilt menu.

Enter the antenna separation: If you did not install the antennas 1.0 m apart,
enter the actual antenna separation In the Ant. Sep field. The available range
is 0-10.0 m.

Configure antenna for roll: Most users install the antennas for pitch;
however, if you install the antennas for roll, you will need to configure the
VS330 for roll. In the Create New menu set the Pitch/Roll setting to Roll.

Save your configuration: To save your new configuration, select the Save to
Location field. You will be prompted for a location to save your
configuration.

Select one of the empty slots, noted by the name Not Used or select a slot
with an existing configuration to overwrite it.

After your configuration is saved, you must select it from the Config Wizard
in order to activate it. You may then continue to enter different receiver
configurations without upsetting the current operation of the receiver. Re-
enter the Config Wizard and select the configuration to use.
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Disabling the Aiding Features

While the default settings will work for most users, you can configure the tilt and gyro
aiding features to further reduce heading startup and re-acquisition times.

Disabling Tilt Aiding

The VS330's tiltaid (accelerometer) is enabled by default and constrains the RTK
heading solution to reduce startup and re acquisition times. The tiltaid is precalibrated
at the factory; however, if you experience any tilt measurement offset, you can
recalibrate the tilt sensor via the Calibrate Tilt option in the Vector menu. See “Vector
menu” on page 50 for a menu map on how to access this feature.

Note: Make sure the receiver is perfectly level before recalibrating the tiltaid.

The only times you may need to disable the tiltaid feature are:

. If you were unable to install the VS330 on a level plane with the antennas.
The tilt sensor is located inside the VS330, so it is important that you install
the VS330 on a level horizontal plane.

YNILGLUINEH  If you were unable to install the VS330 in a horizontal plane
with the antennas, you must disable tiltaid. Failure to do so may cause
erratic equipment behavior.

. If troubleshooting, to ensure the receiver is working properly.

You can turn tilt aiding off either through the Config Wizard or Vector menus.

Disabling Gyro Aiding
The VS330's internal gyro-aid is enabled by default. The gyro:

. Shortens re-acquisition times when satellites are obstructed and heading is
lost, by reducing the search volume required for the RTK solution, and

. Provides accurate substitute headings for a short period (depending on the
roll and pitch of the vessel) ideally seeing you through to re-acquisition.

The only time you might need to disable the gyro-aid is during troubleshooting, to
ensure the receiver is working properly.

YNWEGLIINER Do not exceed turn rates of 90%sec. The VS330 uses gyro
measurements to obtain a heading rate measurement and the gyro cannot measure
beyond this rate.

You can turn the gyroaid feature off either through the Config Wizard menu or the
Vector menu.
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Adjusting the Time Constants

The VS330's default settings are fine for most users; however, you can set the time
constants to further smooth heading, course-over-ground (COG), and speed
measurements. Table 4-3 provides an overview of the time constant values you can
set in the Config Wizard, including the formulas for finding the optimal value of each
time constant for your vessel.

Table 4-3: Time constants

(Rate of Turn)

LD Description
Constant P
COGTAU Adjust the responsiveness to the course over ground measurement. If
(Course Over | vessel is small and dynamic, leave this value at 0.0 s to be conservative.
Ground) If the vessel is large and resistant to motion, you may want to increase
this value.
Default value: 0.0 s
Range: 0.0to 60 s
Formula: cogtau (s) = 10 / max rate of change of course (O/sec)
HRTAU Adjust the responsiveness to the rate of heading change. If vessel is large

and unable to turn quickly, you may want to increase this value.

Default value: 2.0 s with gyro enabled
Range: 0.0to 60 s

Formula: hrtau (s) = 10 / max rate of the rate of turn (O/sz)

HTAU Adjust the responsiveness to true heading. If vessel is large and unable
(Heading) to turn quickly, you may want to increase this value.

For longer baselines (10 m) HTAU should be between 0.1 and 0.5, since

the gyro introduces noise.

Default value: 0.1 s with gyro enabled

Range: 0.0to 60 s

Formula: htau (s) = 40 / max rate of turn (°/s) with gyro ON

htau (s) = 10 / max rate of turn (O/s) with gyro OFF

PTAU Adjust the responsiveness to pitch. If vessel is large and unable to pitch
(Pitch) quickly, may want to increase this value.

Default value: 0.5 s

Range: 0.0to 60 s

Formula: ptau (s) = 10 / max rate of pitch (o/s)
SPDTAU Adjust the responsiveness to speed. If vessel is small and dynamic, leave
(Speed) this value at 0.0 s to be conservative. If the vessel is large and resistant to

motion, you may want to increase this value.

Default value: 0.0 s
Range: 0.0to 60 s

Formula: spdtau (s) = 10 / max acceleration (m/s?)
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Connecting to Existing Navigation Systems

Most users connect the VS330 to their existing navigation system during installation.
These users will receive the VS330’s position and heading updates through the
interface of their existing system.

Viewing GNSS/DGPS Status

Most users will receive position and heading information through their on-board
navigation system. If you have not connected the VS330 to an existing navigation
system, or are troubleshooting your unit, you may need to view GNSS, DGPS, or
beacon status on the VS330’s display screen.

Do | Have a Signal?

Figure 4-2 on page 27 shows which LEDs on the VS330 will indicate GNSS, DGPS or
Beacon signal lock when illuminated. If you lose the differential signal lock,
Hemisphere GPS COAST technology allows the VS330 to perform well for 40 minutes
or more with aging differential GNSS correction data. The amount of time you can
“coast” depends on the degree of tolerable drift.

Note: To obtain a full set of SBAS corrections, the VS330 must receive the
ionospheric map over a period of a few minutes. After this, the receiver can “coast”
until the next set of corrections has been received.

How Good is the Quality of My Signal?

In addition to the LED indicators for signal lock, the
VS330’s display indicates signal quality. The bars
along the top of the display represent the quality of the
GNSS and DGPS (or if applicable, beacon) signal. The
first group of bars shows the GPS signal; the second
group shows the DGPS or beacon signal. Each bar GPS signal DGPS or beacon
represents a distinct channel and its associated signal  jndicator
quality. The higher the bar, the better the signal.

signal indicator

Note: If using autonomous or external correction mode, the DGPS signal indicator
will not appear in the display.

DGPS (SBAS)

The differential correction (or SBAS) signal indicator reflects the quality of each
satellite signal, or the bit error rate (BER). A full bar height reflects a signal lock and a
BER of 0. A bar height only 2 pixels tall reflects a signal loss, or BER, of 500 or greater.
Bar heights in between reflect intermediate degrees of signal quality. For example,
when using WAAS two satellites are available, so two BERs are provided.

Beacon

The beacon indicator reflects the quality of the beacon signal, or the signal strength
(SS) and the signal-to-noise ratio (SNR). A full bar height reflects a signal lock,
SS>=35, and SNR>=24. A bar height only 2 pixels tall reflects a signal loss, or SS and
SNR values of 0. Bar heights in between reflect intermediate degrees of signal quality.
If using beacon, the first bar indicates SS signal quality; the second bar indicates SNR
signal quality.
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USB Data Logging

When you insert a USB flash drive into the VS330, the Data Logging menu indicates
you can start recording (logging data) and displays the free space on the flash drive
(see Figure 4-4). When you start logging data the “Start Recording” indicator changes
to “End <filename>."

Config > Config >
NO DISK PRESENT Start Recording
Back > 457.5 Mb Free
Top Menu > Back >
Top Menu >
With no USB flash With USB flash
drive inserted drive inserted

Figure 4-4: USB flash drive indicators on Data Logging menu

YN\WAGUIINER  Stop data logging before removing the USB flash drive from the
VS330. Failure to do so may result in a loss of data.

Selecting the Data File Type and Log Options
You can log the following data types to a USB flash drive:

. RAW - binary, NMEA, and other data options (see Table 4-4)
. KML - Google Earth KML format with latitude, longitude and height

. CSV - comma-separated value (CSV) format with time, latitude, longitude,
and height

. PostPro - VS330 automatically turns on the appropriate messages for post
processing

. debug - VS330 logs high speed data for troubleshooting purposes (contact
Hemisphere GPS Technical Support for more information)

Table 4-4: RAW data log options

Format Description

Raw (binary) For raw (binary) data logging, you may also want the receiver
configuration to be inserted into the file. If you select this option the file
will start with the receiver configuration comprised of the replies to the
$J1, $JK, $JT, and $JSHOW queries.

NMEA National Marine Electronics Association (NMEA 0183) - industry
standard data transmission format

CMR Proprietary data correction format

DFX Hemisphere GPS-proprietary data correction format

ROX Hemisphere GPS-proprietary data correction format

RTCM Radio Technical Commission for Maritime Services - industry standard

data correction format
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To select a data logging type:
1. Select Data Logging > Config > FileType.
2. Press the Up/Down Arrow buttons until your preferred data type appears
then press Enter.

When logging using the RAW data type (File Type > RAW as shown in Figure 4-5) you
can select which data to log and at what rate by selecting Data Logs and then making
the desired selections on the Data Logs menu.

GPGGA > 1 Hz
GPGLL > Off
GPGNS > Off
GNGNS > Off
GPGSA > Off
GNGSA > Off
GPGST > Off
GPGSV > 1 Hz
GLGSV > Off
GPHDT > Off
GPHEV > Off
HPR > Off

PASHR > Off
GPRMC > Off
GPROT > Off
GPRRE > Off
TSS1 > Off

GPVTG > Off
Auto—Name.> YES GPZDA > Off
AédeConflg > YES Binl > Off
FileType > RAW _ Bin2 > Off
EENEE) MEERS 2 »| Bin62 > off
ERes & Bin65 > Off
uEp LTS 2 Bin66 > Off
Bin69 > Off
Bin76 > Off
Bin80 > Off
Bin89 > Off
Bin94 > Off
Bin95 > Off
Bin96 > Off
Bin97 > Off
Bin98 > Off
Bin99 > Off
Binl00 > Off
RD1 > Off

PCSI,1 > Off
RTCMv3 > Off
CMR > Off
ROX > Off
DFX > Off
Back >

Figure 4-5: Data Logging > Config > Data Logs menu

Note: Logged data options are limited by your receiver subscriptions (certain
options may not appear on the Data Logs menu without a specific subscription). For
example, GNGNS, GNGSA, GLGSV, Bin62, Bin65, Bin66, and Bin69 only appear on
the Data Logs menu if you are authorized to receive GLONASS. To view your
subscriptions press System Setup > Software Disp > Authorizations.
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Logging Data to a File

You can log data to a file that the VS330 auto-generates or you can manually enter a
filename to which to log data. You can append data to or overwrite data on a
manually-named file; however, you cannot append data to or overwrite data on an
VS330-generated file.

To log data to an VS330 auto-generate filename:

1.

o b wNn

6.

Select Data Logging > Config.

If Auto-Name displays No select Auto-Name and then press Enter.
Select Yes and then press Enter.

Select Back to return to the Data Logging menu.

Select Start Recording to begin logging data. The Start Recording option
changes to End <filename>.

Select End <filename>.

To log data to a manually-created filename:

1
2.
3.

Select Data Logging > Config.
If Auto-Name displays Yes select Auto-Name and then press Enter.

Select No and press Enter. The Enter Name and Mode menu items appear
below Auto-Name.

Enter a filename:
a. Select Enter Name and press Enter.

b. Enter the desired characters for the filename and then scroll to the
return character and press Enter.

Select the mode:
a. Select Mode and press Enter.

b. Select Append to log data to new file or to append data to an existing
file (based on the filename in step 4) and press Enter.

or

Select Overwrite to overwrite an existing file (based on the filename in
step 4) and press Enter.

YNUWLEGUTNER No warnings are given to confirm overwriting a
previous file.

Select Back to return to the Data Logging menu.

Select Start Recording to begin logging data. The Start Recording option
changes to End <filename>.

Select End <filename>.
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Data Post-Processing

After you log data you can then process the data with a Receiver Independent
Exchange (RINEX) format software utility. Hemisphere GPS Rinex conversion software
is available from the Hemisphere GPS website at www.hemispheregps.com.

Make sure you select PostPro as the file type before logging the data you will use for
post processing (see “Selecting the Data File Type and Log Options” on page 36).

To post-process raw data:

1. Logthe raw data to the USB flash drive inserted in the VS330. Make sure you
properly end your data logging before removing the flash drive in step 2
below.

2. Remove the flash drive from the VS330 then insert the drive in a PC with
Hemisphere GPS’ Rinex conversion software installed.

3. Run the Rinex conversion software.
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Table A-1 provides troubleshooting for common problems.

Table A-1: Troubleshooting

Symptom Possible Solution

Receiver fails to power e Verify polarity of power leads
e Check integrity of power cable connectors
e Check power input voltage (8 to 36 VDC)

e Check current restrictions imposed by power source
(minimum available should be > 1.0 A)

No data from VS330 e Check receiver power status to ensure the receiver is
powered (an ammeter can be used for this)

e Verify desired messages are activated (using VectorPC
or $JSHOW in any terminal program)

e Ensure the baud rate of the VS330 matches that of the
receiving device

e Check integrity and connectivity of power and data
cable connections

Random data from VS330 e Verify the RTCM or binary messages are not being
output accidentally (send a $JSHOW command)

e Ensure the baud rate of the VS330 matches that of the
remote device

e Potentially, the volume of data requested to be output
by the VS330 could be higher than the current baud

rate supports (try using 19200 as the baud rate for all
devices or reduce the amount of data being output)

No GPS lock e Verify the VS330 has a clear view of the sky

e  Verify the lock status of GPS satellites (this can be done
with VectorPC)

No beacon lock e Verify the receiver is tuned to the correct frequency and
bit rate

e Ensure beacon signal coverage is expected in your
area

e Ensure environmental noise is not masking the signal,
reducing the SNR reading

No SBAS lock e Verify the VS330 has a clear view of the sky

e  Verify the lock status of SBAS satellites (this can be
done with VectorPC - monitor BER value)

e Set SBAS mode to automatic with the
$JWAASPRN,AUTO command

SBAS lock is only possible if you are in an appropriate
SBAS region; currently, there is limited SBAS availability in
the southern hemisphere.
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Table A-1: Troubleshooting (continued)

Symptom

Possible Solution

No heading or incorrect
heading value

Check CSEP value is fairly constant without varying
more than 1 cm (0.39 in)—larger variations may
indicate a high multipath environment and require
moving the receiver location

The standard antenna mounting configuration
provides a 0.5° heading accuracy at 95% confidence. If
you require more performance, you will need to
increase the antenna separation (maximum
recommended separation is 10.0 m). See Table D-1 on
page 58 for antenna separation specifications.
Recalibrate the tilt sensor with $JATT, TILTCAL
command if heading is calculated then lost at
consistent time intervals

Heading is from primary GPS antenna to secondary
GPS antenna

$JATT,SEARCH command forces the VS330 to acquire
a new heading solution (unless gyro is enabled)

Enable GYROAID to provide heading for up to three
minutes during GPS signal loss

Enable TILTAID to reduce heading search times

Monitor the number of satellites and SNR values for
both antennas within VectorPC—at least four satellites
should have strong SNR values

Potentially, the volume of data requested to be output
by the VS330 could be higher than the current baud
rate supports (try using 19200 as the baud rate for all
devices or reduce the amount of data being output)

No DGPS position in
external RTCM mode

Verify the baud rate of the RTCM input port matches
the baud rate of the external source

Verify the pinout between the RTCM source and the
RTCM input port (transmit from the source must go to
receive of the RTCM input port and grounds must be
connected)

Ensure corrections are being transmitted to the correct
port—using the $JDIFEPORTB command on Port A will
cause the receiver to expect the corrections to be input
through Port B
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This appendix covers power, communication and external RTCM questions. For GPS
and Heading troubleshooting, see Chapter 4, “Operating the VS330."

Q: Can COAST technology work with corrections from an external source?

A: Yes, the VS330 will operate in a similar fashion with COAST technology as when
using SBAS or Beacon corrections. However, SBAS corrections have the advantage
that they are separated into separate error components, allowing the VS330 to
anticipate how errors will change over the coasting period with more consistent
accuracy and for a longer period than regular RTCM range corrections.

Q: My VS330 does not appear to be communicating. What do | do?
A: This could be one of the following issues:
. Examine the power cable and its connector for signs of damage.

. Ensure you are properly powering the system with the correct voltage (8 to
36 VDC) by measuring the voltage at the receiver end of the power cable
when the cable is connected to the power source.

. Check current restrictions imposed by power source (minimum available
should be > 1.0 A).

e  Verify the display has turned on and that time is incrementing in the upper
right corner of the display, and configure the COM port baud rates
appropriately through the menu system.

. Verify polarity of power leads.
. Check the 1.0 A inline power cable fuse.

. Since you are required to terminate the power input with your choice of
connector, ensure you have made a good connection to the power supply.

. Consult the troubleshooting section of the other device’s reference manual
to determine if there is an issue with that device.

Q: Am | able to configure the two serial ports with different baud rates?

A: Yes, the ports are independent. For example, you may have one port set to 4800
and the other to 19200 or vice versa.

Q: Am | able to have the VS330 output different NMEA messages through
the two ports?

A: Yes, you may have different NMEA messages turned on for the two serial ports.
Further, these NMEA messages may also be at different update rates.

Q: How do | determine the current configuration of the VS330?

A: You can view the current configuration from various screens of the menu, which
show all configurable items of the receiver. Alternately, you can select Config Wizard
> Use Previous to return the receiver to a previously saved (known) configuration.

Q: My VS330 does not appear to be using corrections from an external
correction source. What could be the problem?

A: This could be due to a number of issues. Check the following items.
. Make sure the corrections are of an RTCM SC-104 protocol.

. Verify the baud rates of the port used by the VS330 match that of the external
correction source.
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. The external correction source should be using an 8 data bit, no parity, 1
stop bit (8-N-1) serial port configuration.

. Inspect the cable connection to ensure there are no signs of damage.

. Check the pinout information for the cables to ensure the transmit line of the
external correction source is connected to the receive line of the VS330’s
serial port and that the signal grounds are connected.

Save the configuration as the profile named “RTCM” in the Config Wizard, cycle
the power and load the RTCM profile.

Q: Why am | not getting data from the VS330?
A: There are several possible reasons for this. Check the following items.
. Check receiver power status LED to ensure the receiver is powered.

e  Verify the VS330 is locked to a valid DGPS signal (this can often be done on
the receiving device or with VectorPC).

. Verify the VS330 is locked to GPS satellites (this can often be done on the
receiving device or with VectorPC).

. Check the integrity and connectivity of power and data cable connections.

Q: Why am | getting random data from VS330?
A: There are three possible reasons for this. Check the following items.

. Verify the RTCM or the Bin95 and Bin96 messages are not being output
accidentally (send a $JSHOW command).

o Verify the baud rate settings of VS330 and remote device match correctly.

o Potentially, the volume of data requested to be output by the VS330 could be
higher than the current baud rate supports. Try increasing the baud rate to
38400 for all devices or reduce the amount of data being output.

Q: | could not install my antennas at the same height. How do | calibrate for
the height offset?

A: You may enter an non-level bias calculation that adjusts the pitch/roll output to
calibrate the measurement if the antenna array is not installed on a horizontal plane.

To calibrate the pitch/roll reading, send the following command:
$JATT,PBIAS, x<CR><LF>

where x is a bias (in degrees) that will be added to the pitch/roll measurement.
The acceptable pitch bias range is -15.0° to 15.0° (default is 0.0°).

To determine the current pitch compensation angle, send the following command:
$JATT,PBIAS<CR><LF>

The pitch/roll bias is added after the negation of the pitch/roll measurement (if so
invoked with the $JATT,NEGTILT command).
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Vector Menu

GNSS Menu
Differential Menu
Config Wizard Menu
System Setup Menu
Data Logging Menu
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This appendix shows the complete menu map for each menu (listed below) on the

VS330 Top menu:

. Vector
. GNSS

. Differential (menu item will be the selected differential source, such as SBAS

or Autonomous)
o Config Wizard
. System Setup
. Data Logging

Vector Menu

Use the Vector menu to view and adjust Vector settings. Options vary depending on
whether you select Pitch or Roll and include such items as aiding features, time
constants, heading bias, and antenna separation.

Vector >

GNSS >

Differential >
Config Wizard >
System Setup >
Data Logging >

h 4

Heading 180.00
CoG 10.00

Vel 25.3 km/h
ROT 3.2

Pitch 0.0

Roll 6.2

Heave 0.11 m
Back >

Top Menu >

Display >

Aiding Features >
Time Constants > —

Bias, Neg, Tilt >

Antenna Sep. >
Pitch/Roll > Pitch
Back >

Top Menu >

Figure C-1: Vector menu

h 4

Gyroaid > YES
Tiltaid > YES
Calibrate tilt >
Back >

Top Menu >

HTAU > 0.5
HRTAU > 0.
coG > 0.0

SPEED > 0.
PTAU > 0.0
Back >

Top Menu >

0

5

h 4

Heading > 0.0
Pitch/Roll > 0.0
Neg Tilt > NO
Level Op. > YES
Back >

Top Menu >

\ 4

Computed > 0.550m
Measured > 0.550m
Back >

Top Menu >
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GNSS Menu

Use the GNSS menu to view and edit your GNSS settings. Settings include the data
port outputs, specific positioning parameters, UTC time offset, and satellite visibility
and positioning information.

Lt 51°00.131035"' Res rms: 0.300m
Ln 114°00.273158" o-a: 0.200m
Hgt 1030.400 m o-b: 0.100m
CoG 236.65 Azimuth: 163.10°
Vel 10.5 km/h —p| o-Lat: 0.200m
Menu item is “GNSS” if your VS330 &p G006 ogLon:N0200m
is optioned for GLONASS; otherwise, 57 (s 2 oLliEs . etim
; P ” HDOP 1.3 Back >
menu item is “GPS Precision > Top Menu >
NavCnd > ABBABB —
DSP-ARM > 1F-1F —
Back > Car Smooth 11
Top Menu > N
Eph Exists 11
e / Position Status > S9n ey 19
S Eele 2 CHO1-SV02 EL 39 gztusedlhev ﬂ
Differential > -|_> GLONASS Sats > — ) SHICE SR D=5 g | SO0 O
Config Wizard > Configure > DEE Gome 1y
System Setup > Back > B BHEE G O
Data Logging > Top Menu > . e >
CH12-SV28 EL 32 Top Menu >
AZ 99 SNR 45-47
Back >
Top Menu > DSP: CarLock YES
DSP: BER YES
‘GLONASS Sats’ only appears if your DSP: DSPLock YES
VS330 is optioned for GLONASS DSP: FrmSync YES
CHOR~EID b 19 DSP: TrkMode YES
LZRSORSHERLC ARM: GPSLock YES
—| ARm: Difpata YES
ARM: ARMLock YES
—> - ARM: DGPS YES
CH12-SV88 EL 16 ARM: Solutn YES
AZ 74 SNR 45-44 Back >
s 2 Top Menu >
BASE > No Top Menu >
FOREST > NO
GPSONLY > NO
LIONLY > NO Elev Mask > 5°
MIXED > NO MaxDGPSAge > 2700
NULLNMEA > NO Data PORT A >
SBASR > NO Data PORT B >
TIMEKEEP > NO < P UTC Offset > -THr
TUNNEL > NO GGAALLGNSS > No
GLOFIX > NO Rx Modes >
FIXLOC > NO Back >
SURETRACK > YES Top Menu >
SBASNORTK > NO
Back >
Top Menu >

Figure C-2: GNSS menu
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Differential Menu

Use the Differential menu to view or change your differential settings. The following
available differential sources depend on the configuration you purchased.

. SBAS
. Beacon (RTCM2) - available with purchased unlock code
. RTK (CMR, ROX, RTCM3)

. L-band (OMNIVBS, OMNIHP) - available with purchased unlock code

. None (Autonomous)

To select the differential source:

1.  Press Differential > Include then set each format you may use to Yes. For

example, if you will be using Beacon, set RTCM2 to Yes.

2. Press Back to return to the previous menu level, press InUse, then select
your preferred differential source. For example, if you will be using Beacon,

select Beacon (RTCM2 will be displayed when finished).

Figure C-3 through Figure C-7 show the complete menu maps for

SBAS > YES
the SBAS, Beacon, RTK, L-band, and Autonomous, respectively. OMNIVBS > YES
The Include menu (at right) in each of these figures shows all g‘f;‘z“’: gz
available formats. If you have not purchased unlock codes for DFX > NO
L-band and Beacon, the OMNIVBS/OMNIHP (L-band) and RTCM2 CMR > NO

. . RTCM3 > NO
(Beacon) menu items will not appear on your menu. — et
Back >
Top Menu >
SBAS > YES BER 138: 236
OMNIVBS > YES BER 133: 0
OMNIHP >  YES BER 135: 500
RTCM2 > NO LN 138: -154.0°
DFX > NO LN 133: -97.0°
> or > NO LN 135: 133.0°
RTCM3 > NO | Eleviss:  50.7°
ROX > NO Elev133: 47.2°
Back > Elevl135: 44.9°
Top Menu > Az 138: 171.8°
Az 133: 155.9°
Az 135: 215.0°
Back >
Top Menu >
Vector > InUse SBAS Signal Status > ——
GNSS > Include > Satellites >
Differential > ) SBAS > P Back > Mode > Auto
Config Wizard > Back > Top Menu > PRN1 138
System Setup > Top Menu > PRN2 133
Data Logging > P prN3 135
Back >

Figure C-3: SBAS menu

Top Menu >
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The RTK corrector format you select appears SBAS > YES
next to “InUse” (ROX shown here) OMNIVBS > YES
OMNIHP > YES
RTCM2 > NO
Pl cMR > N
Differential > P\ RTK ETCMEI S Ng
Config Wizard > ack > ROX > NO
System Setup > Top Menu > e
Data Logging > Top Menu >
RTK only appears if at least one of the following DiffPort > PORT B .
is set to YES: CMR, RTCM3, ROX DiffBaud > 19200 ERID S
Radio > p»| Back >
Back > Top Menu >
Top Menu >
Figure C-4: RTK menu
SBAS > YES
OMNIVBS > YES
OMNIHP > YES
RTCM2 > YES
DFX > NO
> CMR > NO
RTCM3 > NO
ROX > NO
Beacon only appears if Back >
RTCM2 is set to YES Top Menu >
F 295.0/200 AA
SS 34 SNR 26
MTP 100% WER 00
Vector > InUse RTCM2 Signal Status > »| Unselected Bx
GNSS > Include > 8
A . Configure > ID 1025 H 08
D:Lffgrent_::.al > P{ Beacon > P Back > Back >
Config Wizard > Back > Top Menu > Top Menu >
System Setup > Top Menu >
Data Logging >
Africa >
Asia > Alexandria VA
Tune: 319.0 100 > Australia > Annette IS AK
Auto Tune > Central America > Bermuda > _
TuneBeaconName > p| Europe > Canada > -
Back > North America > p| USA > >
Top Menu > South America > Back > Youngstown NY
Back > Top Menu > Back >
Top Menu > Top Menu >

Figure C-5: Beacon menu
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SBAS > YES Freq: 1536.7820
OMNIVBS > YES SPS: 1200
OMNIHP > YES BER: 500
RTCM2 > YES .| LN: -101.0°
DFX > NO ¥ Elev: 49.8°
™ or > No Az: 160.7°
L-Band only appears if OMNIVBS and/or RTCM3 > NO Back >
OMNIHP are set to YES ROX > NO Top Menu >
Back >
Top Menu >
Mode > Auto
Freq: 1536.7820
Vector > InUse OMNIHP Signal Status > LT: 45° LN -122°
GNSS > Include > Configure > » Baud: 1200
Differential > p{_L-Band > p»| Subscription > = Back >
Config Wizard > Back > Back > Top Menu >
System Setup > Top Menu > Top Menu >

Data Logging >

Begin: 01/06/1980
End: 03/19/2010
Optns: DRY

Type: SINGLE_SIT
Lib: VBS 2.06
Src: 0

Back >

Top Menu >

Figure C-6: L-band menu

SBAS > YES
OMNIVBS > YES
OMNIHP > YES

RTCM2 > NO
DFX > NO

B CMR > NO
RTCM3 > NO
ROX > NO
Back >

Top Menu >
Autonomous P

Vector > ((InUse None )
GNSS > Include >
Differential > p| None >
Config Wizard > Back >
System Setup > Top Menu >

Data Logging >

Figure C-7: Autonomous menu

Config Wizard Menu

The Config Wizard walks you through basic settings to get up and running. See
“Configuration Wizard” on page 27 to view the Config Wizard menu map.
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System Setup Menu

The System Setup menu allows you quickly view and edit current system settings.
General settings include such items as current applications, units, baud rates, logs,
LED contrast, subscription code, display orientation (you can flip the display 180° by
selecting YES under Flip Display), and language.

1l In Use > MFAATT
2 Other > MFAATT
—p» SwapApplications >
Back >

Top Menu >

Disp Update > 1lHz

LL Unit > DM.M

Hgt Unit > meters
’ Vel Unit > km/h

Back >

Top Menu >

Vector > Display Zpps > PORT A > 9600
GNSS > Display Format >

! ) PORT B > 19200
Differential > Baud Rates > » pack >
Config Wizard > Software Disp > Top Menu >

System Setup > Contrast >
Data Logging > _I—> Animation > Off

Flip Display > NO
LCD Off > never

Language > LTS &

guag RxApp >
Back > S/N >
Top Menu >

SBX >
NDSP >
Authorizations > =

Back >
Top Menu >

‘SBX’ only appears if an SBX beacon
board is installed; DSP only appear if
he application in use is L-band capable

Subs: 7F

Log Rate: 20Hz
e-Dif: YES

RTK: BASE+ROVER
p RAW Data: YES
L2: YES
GLONASS: YES
Back >

Top Menu >

Figure C-8: System Setup menu
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Data Logging Menu

The Data Logging menu allows you to log or output job data, view USB flash drive
free storage space, set up file auto-naming, and view what type of data you are
logging.

GPGGA > 1 Hz
Logged data options are limited by GPGLL > Off
. - . GPGNS > Off
yogrrecmversubscnpuons(cgnam e = ot
options may not appear on this menu GPGSA > Off
without a specific subscription. FOr  mm————— GNGSA > Off
example, GNGNS, GNGSA, GLGSV, GRS 2 i
. . . . GPGSV > 1 Hz
Bin62, Bin65, Bin66, and Bin69 only GLGSV > Off
appear on this menu if you are GPHDT > Off
authorized to receive GLONASS. CEEmT & CrE
HPR > Off
PASHR > Off
GPRMC > Off
GPROT > Off
GPRRE > Off
TSS1 > Off
e —— AutooN Noes GPVTG > Off
ector uto-Name
i _ GPZDA > Off
GNSS > Config > - AddRxConfig > YES
4 q Start Recording N Binl > Off
Differential > FileType > RAW in2 £F
£ig Wizard > XXX.X Mb Free Data Logs > p| Bin2 > O
§°nt g ot Back > e P Bine2 > off
ystem Setup > Top Menu > Back > Bin6é5 > Off
Data Logging > — Top Menu > Bin66 > Off
Bin69 > Off
Bin76 > Off
Bin80 > Off
Bin89 > Off
Bin94 > Off
Bin95 > Off
Bin96 > Off
Bin97 > Off
Bin98 > Off
Bin99 > Off
Binl00 > Off
RD1 > Off
PCSI,1 > Off
RTCMv3 > Off
CMR > Off
ROX > Off
DFX > Off
Back >

Figure C-9: Data Logging menu
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Appendix D: Technical Specifications

VS330 Receiver Specifications
Table D-1 through Table D-8 list the technical specifications of the VS330.

Table D-1: VS330 GNSS sensor specifications

Item

Specification

Receiver type

Vector GNSS L1/L2 RTK

Signals received

GPS, GLONASS, Galileo'

Channels

Two 270-channel

GPS sensitivity

-142 dBm

SBAS tracking

3-channel, parallel tracking

Update rate

10 Hz standard, 20 Hz available by subscription

Horizontal
accuracy

RMS (67%) 2DRMS (95%)
RTK? 10mm+1ppm 20mm+2ppm
L-band DGNSS (VBS/HP/XP/G2)3* 0.08 m 0.16 m
SBAS (WAAS)3 0.25 m 0.50 m
Beacon® 0.25 m 0.50 m
Autonomous, no SA3 1.2m 2.5 m

Heading accuracy

<0.17° rms @ 0.5 m antenna separation
<0.09° rms @ 1.0 m antenna separation
<0.04° rms @ 2.0 m antenna separation
<0.02° rms @ 5.0 m antenna separation
<0.01" rms @10.0 m antenna separation

Pitch/roll accuracy

<1°rms

Heave accuracy

30 cm (DGPS), 10 cm (RTK)®

Timing (1PPS)
accuracy

20 ns

Rate of turn

90°s maximum

Cold start time

<40 s typical (no almanac or RTC)

Warm start time

< 20 s typical (almanac and RTC)

Hot start time

<5 s (almanac, RTC, and position)

Heading fix

< 10 s typical (valid position)

Maximum speed

1,850 kph (999 kts)

Maximum altitude

18,288 m (60,000 ft)

Table D-2: VS330 beacon sensor specifications

Item

Specification

Channels

2-channel, parallel tracking

Frequency range

283.5 to 325 kHz

Operating modes

Manual, automatic, and database

Compliance

IEC 61108-4 beacon standard
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Table D-3: VS330 L-band sensor specifications

Item Specification

Sensitivity -130 dBm

Channel spacing 7.5 kHz

Satellite selection | Manual and automatic

Reacquisition time | 15 seconds (typical)

Rejection 15 kHz spacing > 30 dB
300 kHz spacing > 60 dB

Processor DSP for demodulation and protocol decoding module provides
processing for differential algorithms

Command support| Reports L-band region and satellite information

Allows input and status of L-band subscription, bit error rate (BER)
output for reception quality indication, and manual frequency tuning

Table D-4: VS330 communication specifications

Item Specification

Serial ports 2 full-duplex RS-232, 1 full-duplex RS-422

USB ports 1 USB-A

Baud rates 4800 - 115200

Data 1/0O protocol NMEA 0183, Crescent binary®

Correction 1/0O protocol RTCM v2.3 (DGPS), RTCM v3 (RTK), CMR (RTK), CMR+ (RTK)”
Timing output 1 PPS CMOS, active high, rising edge sync, 10 kC2, 10 pF load

Table D-5: VS330 power specifications

Item

Specification

Power input voltage

8to 36 VDC

Power consumption

< 6.2 W nominal (GNSS L1/L2 L-band)
< 5.3 W nominal (GNSS L1/L2 RTK)

Current consumption

< 0.52 A nominal (GNSS L1/L2 L-band)
< 0.44 A nominal (GNSS L1/L2 RTK)

Power isolation 500 V
Reverse polarity protection Yes
Antenna short circuit protection | Yes
Antenna input impedance 50 Q)

Table D-6: VS330 environmental specifications

Item

Specification

Operating temperature

-30°C to +70°C (-22°F to +158°F)

Storage temperature

-40°C to +85°C (-40°F to +185°F)
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Table D-6: VS330 environmental specifications (continued)

Item

Specification

Humidity

95%, non-condensing

Enclosure rating

IP66 (IEC 60529)

Shock and vibration

Mechanical Shock: EP455 Section 5.14.1
Vibration: EP455 Section 5.15.1 Random

EMC

CE (IEC 60945 Emissions and Immunity), FCC Part 15,
Subpart B, CISPR 22

IMO wheelmarked certification No

Table D-7: VS330 mechanical specifications

Item Specification
Dimensions 20.2L x12.0 Wx 75H (cm)

8.0Lx4.7Wx3.0H(in)
Weight ~1.1 kg (2.5 Ib)

Status indications (LEDs)

Power, primary GPS lock, secondary GPS lock, differential
lock, DGPS position, heading, RTK lock, L-band lock

Power switch

Front panel soft switch

Power connector

2-pin ODU metal circular

Data connectors

(1) DB9 sealed
(1) 9-pin ODU metal circular

Antenna connectors

(2) TNC female

Table D-8: Aiding devices

Item Specification

occurred.®

Gyro Provides smooth heading, fast heading reacquisition and reliable < 1° per
minute heading for periods up to 3 minutes when loss of GPS has

Tilt sensors Provide pitch, roll data and assist in fast start-up and reacquisition of
heading solution.

1Upg rade required

2Depends on multipath environment, number of satellites in view, satellite geometry, baseline
length (for local services), and ionospheric activity

3Depends on multipath environment, number of satellites in view, and satellite geometry

4Requires a subscription from L-band service provider

5Based on a 40 second time constant

6Hemisphere GPS proprietary

"Receive only, does not transmit this format

8Under static conditions
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A42 Antenna Specifications

Table D-9 through Table D-12 list the technical specifications of the A42 antenna.

Table D-9: A42 GNSS sensor specifications

Specification Description

GNSS reception

GPS L1/L2/L5, GLONASS L1/L2, Beidou, SBAS, L-band
DGNSS (VBS/HP/XP/G2), and Galileo E1/Eba and b

GNSS frequency 1.165 to 1.253 GHz
1.525 to 1.613 GHz

LNA gain 30dB

LNA noise 2.0 dB, typical

Table D-10: A42 power specifications

Specification Description
Input voltage 3.3t0 12VDC
Input current 35 mA, typical

Table D-11: A42 mechanical specifications

Specification Description

Enclosure Aluminum base with ASA plastic cap
Dimensions 70H x 13.0 D (cm)
2.9Hx5.1D(in)
Weight 0.38 kg (0.84 Ib)
Mount 5/8"” female thread

RF connector TNC straight

Table D-12: A42 environmental specifications

Specification Description

Operating temperature

-40°C to +70°C (-40°F to +158°F)

Storage temperature

-40°C to +85°C (-40°F to +185°F)

Enclosure rating IP69K

Shock and vibration EP455
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A43 Antenna Specifications
Table D-13 through Table D-18list the technical specifications of the A43 antenna.

Table D-13: A43 GNSS sensor specifications

Specification

Description

GNSS reception

GPS L1/L2/L5, GLONASS L1/L2, BeiDou, SBAS, L-band
DGNSS (VBS/HP/XP/G2), and Galileo E1/E5a and b

GNSS frequency 1.165 to 1.253 GHz
1.525 to 1.613 GHz

LNA gain 30dB

LNA noise 2.0 dB, typical

Table D-14: A43 L-band sensor s

pecifications

Specification

Description

L-Band frequency

1.525 - 1.685 GHz

L-Band LNA gain

30dB

Table D-15: A43 beacon sensor specifications

Specification

Description

Beacon frequency

283.5 - 325 kHz

Beacon LNA gain

30dB

Table D-16: A43 power specifications

Specification

Description

Input voltage

5to 12 VDC

Input current

40 - 50 mA, typical

Table D-17: A43 mechanical spe

cifications

Specification

Description

Enclosure Lexan
Dimensions 10.4 H x 14.5 D (cm)
4.1 Hx 5.7 D (in)
Weight 0.73 kg (1.6 Ib)
Mount 1" coarse thread (5/8" adapter available)
Connector TNC
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Table D-18: A43 environmental specifications

Specification Description

Storage temperature -40°C to +85°C (-40°F to +185°F)
Operating temperature -40°C to +70°C (-40°F to +158°F)
Enclosure rating IP69K

Shock and vibration EP 455
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A52 Antenna Specifications

Table D-9 through Table D-12 list the technical specifications of the A52 antenna.

Table D-19: A42 GNSS sensor specifications

Specification

Description

GNSS reception

GPS L1/L2/L5, GLONASS L1/L2, BeiDou, SBAS, L-band
DGNSS (VBS/HP/XP/G2), and Galileo E1/Eba and b

GNSS frequency 1.165 to 1.253 GHz
1.525 to 1.613 GHz

LNA gain 30dB

LNA noise 2.0 dB, typical

Table D-20: A42 power specifications

Specification

Description

Input voltage

3.3t0 12 VDC

Input current

35 mA, typical

Table D-21: A42 mechanical specifications

Specification

Description

Enclosure Aluminum base with ASA plastic cap
Dimensions 7.6 Hx 18.5 D (cm)
3.0H x 73D (in)
Weight 0.78 kg (1.71 Ib)
Mount 5/8"” female thread

RF connector

TNC straight or right angle

Table D-22: A42 environmental specifications

Specification

Description

Operating temperature

-40°C to +70°C (-40°F to +158°F)

Storage temperature

-40°C to +85°C (-40°F to +185°F)

Enclosure rating

IP69K

Shock and vibration

EP455

Note: The phase center variation is less than 3 mm at GPS L1 and L2 for elevations

above 15 degrees

Vector VS330 GNSS Compass User Guide 64 PN 875-0323-000 Rev B1




Index

Numerics
1 PPS output 22

A

A43 antenna
beacon sensor specifications 62

accelerometer See tilt aid

antenna
cable, routing and securing 19
mounting 16
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CMR (RAW data option) 36
COAST
corrections from external source 46
communication specifications 59
configuration
menu system 29
of the system 30
returning to factory defaults 29
wizard 30, 54
wizard, using 31
CSV data format 36

D
data logging
overview 36
post-processing 39
DFX (RAW data option) 36
DGPS
status 35
DGPS position indicator LED 27

Diff (differential source)
menu map 52

disabling
gyro 33
tilt aid 33
E

environmental

A42 specifications 61

A43 specifications 63

A52 specifications 64
environmental specifications 59
event marker 22

G
GNSS sensor
A42 specifications 61
A43 specifications 62
Ab2 specifications 64
GPS
menu map 51
operation 6
receiver performance 6
specifications 58
gyro 33
aiding 10
calibration, self or manual 10
disabling 33

H
heading 14, 35
bias 14
heading rate time constant 11
HRTAU 11

K
KML data format 36

L
L-Dif
and RTK 7
LED
DGPS position indicator 27
indicators 27
power indicator 27
logging data to a file (instructions) 38

mechanical
A42 specifications 61

Vector VS330 GNSS Compass User Guide 65

PN 875-0323-000 Rev B1



Index

A43 specifications 62
Ab2 specifications 64
menu map 28
Diff (differential source) 52
GPS 50, 51
SBAS 52
system setup 55
vector 50
mounting See antenna mounting
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R
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moving base station 8
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End User License Agreement

IMPORTANT - This is an agreement (the "Agreement") between you, the end purchaser ("Licensee") and Hemisphere
GNSS Inc. ("Hemisphere") which permits Licensee to use the Hemisphere software (the "Software") that accompanies
this Agreement. This Software may be licensed on a standalone basis or may be embedded in a Product. Please read and
ensure that you understand this Agreement before installing or using the Software Update or using a Product.

In this agreement any product that has Software embedded in it at the time of sale to the Licensee shall be referred to as a
"Product". As well, in this Agreement, the use of a Product shall be deemed to be use of the Software which is embedded
in the Product.

BY INSTALLING OR USING THE SOFTWARE UPDATE OR THE PRODUCT, LICENSEE THEREBY AGREES TO BE LEGALLY
BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THESE TERMS, (I) DO NOT INSTALL OR USE
THE SOFTWARE, AND (Il) IF YOU ARE INSTALLING AN UPDATE TO THE SOFTWARE, DO NOT INSTALL THE UPDATE AND
PROMPTLY DESTROY IT.

HEMISPHERE PROVIDES LIMITED WARRANTIES IN RELATION TO THE SOFTWARE. AS WELL, THOSE WHO USE THE
EMBEDDED SOFTWARE DO SO AT THEIR OWN RISK. YOU SHOULD UNDERSTAND THE IMPORTANCE OF THESE AND
OTHER LIMITATIONS SET OUT IN THIS AGREEMENT BEFORE INSTALLING OR USING THE SOFTWARE OR THE PRODUCT.

1. LICENSE. Hemisphere hereby grants to Licensee a non-transferable and non-exclusive license to use the Software
as embedded in a Product and all Updates (collectively the "Software"), solely in binary executable form.

2. RESTRICTIONS ON USE. Licensee agrees that Licensee and its employees will not directly or indirectly, in any
manner whatsoever:

a. install or use more copies of the Software than the number of copies that have been licensed;

b. use or install the Software in connection with any product other than the Product the Software was intended
to be used or installed on as set out in the documentation that accompanies the Software.

c. copy any of the Software or any written materials for any purpose except as part of Licensee's normal backup
processes;

d modify or create derivative works based on the Software;
e. sub-license, rent, lease, loan or distribute the Software;

f. permit any third party to use the Software;
el

use or operate Product for the benefit of any third party in any type of service outsourcing, application service,
provider service or service bureau capacity;

h. reverse engineer, decompile or disassemble the Software or otherwise reduce it to a human perceivable form;

i Assign this Agreement or sell or otherwise transfer the Software to any other party except as part of the sale
or transfer of the whole Product.

3. UPDATES. At Hemisphere's discretion Hemisphere may make Updates available to Licensee. An update
("Update") means any update to the Software that is made available to Licensee including error corrections,
enhancements and other modifications. Licensee may access, download and install Updates during the Warranty
Period only. All Updates that Licensee downloads, installs or uses shall be deemed to be Software and subject to this
Agreement. Hemisphere reserves the right to modify the Product without any obligation to notify, supply or install
any improvements or alterations to existing Software.

4. SUPPORT. Hemisphere may make available directly or through its authorized dealers telephone and email support
for the Software. Contact Hemisphere to find the authorized dealer near you. As well, Hemisphere may make
available user and technical documentation regarding the Software. Hemisphere reserves the right to reduce and
limit access to such support at any time.

5. BACKUPS AND RECOVERY. Licensee shall back-up all data used, created or stored by the Software on a regular
basis as necessary to enable proper recovery of the data and related systems and processes in the event of a
malfunction in the Software or any loss or corruption of data caused by the Software. Licensee shall assume all risks
of loss or damage for any failure to comply with the foregoing.

6. OWNERSHIP. Hemisphere and its suppliers own all rights, title and interest in and to the Software and related
materials, including all intellectual property rights. The Software is licensed to Licensee, not sold.

7 TRADEMARKS. “Hemisphere’; “Hemisphere GPS’, “Hemisphere GNSS’ “Crescent’; “Eclipse” and the associated
logos are trademarks of Hemisphere. Other trademarks are the property of their respective owners. Licensee may
not use any of these trademarks without the consent of their respective owners.

8. LIMITED WARRANTY. Hemisphere warrants solely to the Licensee, subject to the exclusions and procedures set
forth herein below, that for a period of one (1) year from the original date of purchase of the Product in which it is
embedded (the "Warranty Period"), the Software, under normal use and maintenance, will conform in all material
respects to the documentation provided with the Software and any media will be free of defects in materials and
workmanship. For any Update, Hemisphere warrants, for 90 days from performance or delivery, or for the balance of
the original Warranty Period, whichever is greater, that the Update, under normal use and maintenance, will
conform in all material respects to the documentation provided with the Update and any media will be free of
defects in materials and workmanship. Notwithstanding the foregoing, Hemisphere does not warrant that the
Software will meet Licensee's requirements or that its operation will be error free.

9. WARRANTY EXCLUSIONS. The warranty set forth in Section (8) will not apply to any deficiencies caused by (a)
the Product not being used as described in the documentation supplied to Licensee, (b) the Software having been
altered, modified or converted in any way by anyone other than Hemisphere approved by Hemisphere, (c) any
malfunction of Licensee's equipment or other software, or (d) damage occurring in transit or due to any accident,
abuse, misuse, improper installation, lightning (or other electrical discharge) or neglect other than that caused by
Hemisphere. Hemisphere does not warrant or guarantee the precision or accuracy of positions obtained when using
the Software (whether standalone or embedded in a Product). The Product and the Software is not intended and
should not be used as the primary means of navigation or for use in safety of life applications. The potential
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positioning and navigation accuracy obtainable with the Software as stated in the Product or Software
documentation serves to provide only an estimate of achievable accuracy based on specifications provided by the
US Department of Defense for GPS positioning and DGPS service provider performance specifications, where
applicable.

WARRANTY DISCLAIMER. EXCEPT AS EXPRESSLY SET OUT IN THIS AGREEMENT, HEMISPHERE MAKES NO
REPRESENTATION, WARRANTY OR CONDITION OF ANY KIND TO LICENSEE, WHETHER VERBAL OR WRITTEN
AND HEREBY DISCLAIMS ALL REPRESENTATIONS, WARRANTIES AND CONDITIONS OF ANY KIND INCLUDING
FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, ACCURACY, RELIABILITY OR THAT THE USE OF THE
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE AND HEREBY DISCLAIMS ALL REPRESENTATIONS,
WARRANTIES AND CONDITIONS ARISING AS A RESULT OF CUSTOM, USAGE OR TRADE AND THOSE ARISING
UNDER STATUTE.

LIMITS ON WARRANTY DISCLAIMER. Some jurisdictions do not allow the exclusion of implied warranties or
conditions, so some of the above exclusions may not apply to Licensee. In that case, any implied warranties or
conditions which would then otherwise arise will be limited in duration to ninety (90) days from the date of the
license of the Software or the purchase of the Product. The warranties given herein give Licensee specific legal rights
and Licensee may have other rights which may vary from jurisdiction to jurisdiction.

CHANGE TO WARRANTY. No employee or agent of Hemisphere is authorized to change the warranty provided or
the limitation or disclaimer of warranty provisions. All such changes will only be effective if pursuant to a separate
agreement signed by senior officers of the respective parties.

WARRANTY CLAIM. In the event Licensee has a warranty claim Licensee must first check for and install all
Updates that are made available. The warranty will not otherwise be honored. Proof of purchase may be required.
Hemisphere does not honor claims asserted after the end of the Warranty Period.

LICENSEE REMEDIES. In all cases which involve a failure of the Software to conform in any material respect to the
documentation during the Warranty Period or a breach of a warranty, Hemisphere's sole obligation and liability, and
Licensee's sole and exclusive remedy, is for Hemisphere, at Hemisphere's option, to (a) repair the Software, (b)
replace the Software with software conforming to the documentation, or (c) if Hemisphere is unable, on a
reasonable commercial basis, to repair the Software or to replace the Software with conforming software within
ninety (90) days, to terminate this Agreement and thereafter Licensee shall cease using the Software. Hemisphere
will also issue a refund for the price paid by Licensee less an amount on account of amortization, calculated on a
straight-line basis over a deemed useful life of three (3) years.

LIMITATION OF LIABILITY. IN NO EVENT WILL HEMISPHERE BE LIABLE TO LICENSEE FOR ANY INCIDENTAL,
CONSEQUENTIAL, SPECIAL OR INDIRECT DAMAGES INCLUDING ARISING IN RELATION TO ANY LOSS OF DATA,
INCOME, REVENUE, GOODWILL OR ANTICIPATED SAVINGS EVEN IF HEMISPHERE HAS BEEN INFORMED OF THE
POSSIBILITY OF SUCH LOSS OR DAMAGE. FURTHER, IN NO EVENT WILL HEMISPHERE'S TOTAL CUMULATIVE
LIABILITY HEREUNDER, FROM ALL CAUSES OF ACTION OF ANY KIND, EXCEED THE TOTAL AMOUNT PAID BY
LICENSEE TO HEMISPHERE TO PURCHASE THE PRODUCT. THIS LIMITATION AND EXCLUSION APPLIES
IRRESPECTIVE OF THE CAUSE OF ACTION, INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT,
NEGLIGENCE, STRICT LIABILITY, TORT, BREACH OF WARRANTY, MISREPRESENTATION OR ANY OTHER LEGAL
THEORY AND WILL SURVIVE A FUNDAMENTAL BREACH.

LIMITS ON LIMITATION OF LIABILITY. Some jurisdictions do not allow for the limitation or exclusion of liability for
incidental or consequential damages, so the above limitation or exclusion may not apply to Licensee and Licensee
may also have other legal rights which may vary from jurisdiction to jurisdiction.

BASIS OF BARGAIN. Licensee agrees and acknowledges that Hemisphere has set its prices and the parties have
entered into this Agreement in reliance on the limited warranties, warranty disclaimers and limitations of liability set
forth herein, that the same reflect an agreed-to allocation of risk between the parties (including the risk that a
remedy may fail of its essential purpose and cause consequential loss), and that the same forms an essential basis
of the bargain between the parties. Licensee agrees and acknowledges that Hemisphere would not have been able
to sell the Product at the amount charged on an economic basis without such limitations.

PROPRIETARY RIGHTS INDEMNITY. Hemisphere shall indemnify, defend and hold harmless Licensee from and
against any and all actions, claims, demands, proceedings, liabilities, direct damages, judgments, settlements, fines,
penalties, costs and expenses, including royalties and attorneys' fees and related costs, in connection with or arising
out of any actual infringement of any third party patent, copyright or other intellectual property right by the Software
or by its use, in accordance with this Agreement and documentation, PROVIDED THAT: (a) Hemisphere has the right
to assume full control over any action, claim, demand or proceeding, (b) Licensee shall promptly notify Hemisphere
of any such action, claim, demand, or proceeding, and (c) Licensee shall give Hemisphere such reasonable
assistance and tangible material as is reasonably available to Licensee for the defense of the action, claim, demand
or proceeding. Licensee shall not settle or compromise any of same for which Hemisphere has agreed to assume
responsibility without Hemisphere's prior written consent. Licensee may, at its sole cost and expense, retain
separate counsel from the counsel utilized or retained by Hemisphere.

INFRINGEMENT. If use of the Software may be enjoined due to a claim of infringement by a third party then, at its
sole discretion and expense, Hemisphere may do one of the following: (a) negotiate a license or other agreement so
that the Product is no longer subject to such a potential claim, (b) modify the Product so that it becomes non-
infringing, provided such modification can be accomplished without materially affecting the performance and
functionality of the Product, (c) replace the Software, or the Product, with non-infringing software, or product, of
equal or better performance and quality, or (d) if none of the foregoing can be done on a commercially reasonable
basis, terminate this license and Licensee shall stop using the Product and Hemisphere shall refund the price paid by
Licensee less an amount on account of amortization, calculated on a straight-line basis over a deemed useful life of
three (3) years.

The foregoing sets out the entire liability of Hemisphere and the sole obligations of Hemisphere to Licensee in
respect of any claim that the Software or its use infringes any third party rights.

INDEMNIFICATION. Except in relation to an infringement action, Licensee shall indemnify and hold Hemisphere
harmless from any and all claims, damages, losses, liabilities, costs and expenses (including reasonable fees of
lawyers and other professionals) arising out of or in connection with Licensee's use of the Product, whether direct or
indirect, including without limiting the foregoing, loss of data, loss of profit or business interruption.



21.

22.

23.

24.

25.

26.

27.

28.

TERMINATION. Licensee may terminate this Agreement at any time without cause. Hemisphere may terminate this
Agreement on 30 days notice to Licensee if Licensee fails to materially comply with each provision of this
Agreement unless such default is cured within the 30 days. Any such termination by a party shall be in addition to
and without prejudice to such rights and remedies as may be available, including injunction and other equitable
remedies. Upon receipt by Licensee of written notice of termination from Hemisphere or termination by Licensee,
Licensee shall at the end of any notice period (a) cease using the Software; and (b) return to Hemisphere (or destroy
and provide a certificate of a Senior Officer attesting to such destruction) the Software and all related material and
any magnetic or optical media provided to Licensee. The provisions of Sections 6), 7), 8), 9), 10), 15), 21), 26) and 27)
herein shall survive the expiration or termination of this Agreement for any reason.

EXPORT RESTRICTIONS. Licensee agrees that Licensee will comply with all export control legislation of Canada,
the United States, Australia and any other applicable country's laws and regulations, whether under the Arms
Export Control Act, the International Traffic in Arms Regulations, the Export Administration Regulations, the
regulations of the United States Departments of Commerce, State, and Treasury, or otherwise as well as the export
control legislation of all other countries.

PRODUCT COMPONENTS. The Product may contain third party components. Those third party components may
be subject to additional terms and conditions. Licensee is required to agree to those terms and conditions in order to
use the Product.

FORCE MAJEURE EVENT. Neither party will have the right to claim damages as a result of the other's inability to
perform or any delay in performance due to unforeseeable circumstances beyond its reasonable control, such as
labor disputes, strikes, lockouts, war, riot, insurrection, epidemic, Internet virus attack, Internet failure, supplier
failure, act of God, or governmental action not the fault of the non-performing party.

FORUM FOR DISPUTES. The parties agree that the courts located in the State of Arizona and the courts of appeal
there from will have exclusive jurisdiction to resolve any disputes between Licensee and Hemisphere concerning
this Agreement or Licensee's use or inability to use the Software and the parties hereby irrevocably agree to attorn
to the jurisdiction of those courts. Notwithstanding the foregoing, either party may apply to any court of competent
jurisdiction for injunctive relief.

APPLICABLE LAW. This Agreement shall be governed by the laws of the State of Arizona, exclusive of any of its
choice of law and conflicts of law jurisprudence.

CISG. The United Nations Convention on Contracts for the International Sale of Goods will not apply to this
Agreement or any transaction hereunder.

GENERAL. This is the entire agreement between Licensee and Hemisphere relating to the Product and Licensee's
use of the same, and supersedes all prior, collateral or contemporaneous oral or written representations, warranties
or agreements regarding the same. No amendment to or modification of this Agreement will be binding unless in
writing and signed by duly authorized representatives of the parties. Any and all terms and conditions set out in any
correspondence between the parties or set out in a purchase order which are different from or in addition to the
terms and conditions set forth herein, shall have no application and no written notice of same shall be required. In
the event that one or more of the provisions of this Agreement is found to be illegal or unenforceable, this
Agreement shall not be rendered inoperative but the remaining provisions shall continue in full force and effect.



Warranty Notice

COVERED PRODUCTS: This warranty covers all products manufactured by Hemisphere GNSS and purchased by the
end purchaser (the "Products"), unless otherwise specifically and expressly agreed in writing by Hemisphere GNSS.

LIMITED WARRANTY: Hemisphere GNSS warrants solely to the end purchaser of the Products, subject to the exclusions
and procedures set forth below, that the Products sold to such end purchaser and its internal components shall be free,
under normal use and maintenance, from defects in materials, and workmanship and will substantially conform to
Hemisphere GNSS’ applicable specifications for the Product, for a period of 12 months from delivery of such Product to
such end purchaser (the “Warranty Period”). Repairs and replacement components for the Products are warranted, subject
to the exclusions and procedures set forth below, to be free, under normal use and maintenance, from defects in material
and workmanship, and will substantially conform to Hemisphere GNSS’ applicable specifications for the Product, for 90
days from performance or delivery, or for the balance of the original Warranty Period, whichever is greater.

EXCLUSION OF ALL OTHER WARRANTIES. The LIMITED WARRANTY shall apply only if the Product is properly and
correctly installed, configured, interfaced, maintained, stored, and operated in accordance with Hemisphere GNSS’
relevant User’s Manual and Specifications, AND the Product is not modified or misused. The Product is provided “AS I1S”
and the implied warranties of MERCHANTABILITY and FITNESS FOR A PARTICULAR PURPOSE and ALL OTHER
WARRANTIES, express, implied or arising by statute, by course of dealing or by trade usage, in connection with the
design, sale, installation, service or use of any products or any component thereof, are EXCLUDED from this transaction
and shall not apply to the Product. The LIMITED WARRANTY is IN LIEU OF any other warranty, express or implied,
including but not limited to, any warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE, title, and non-
infringement.

LIMITATION OF REMEDIES. The purchaser’s EXCLUSIVE REMEDY against Hemisphere GNSS shall be, at Hemisphere
GNSS’ option, the repair or replacement of any defective Product or components thereof. The purchaser shall notify
Hemisphere GNSS or a Hemisphere GNSS’ approved service center immediately of any defect. Repairs shall be made
through a Hemisphere GNSS approved service center only. Repair, modification or service of Hemisphere GNSS products
by any party other than a Hemisphere GNSS approved service center shall render this warranty null and void. The remedy
in this paragraph shall only be applied in the event that the Product is properly and correctly installed, configured,
interfaced, maintained, stored, and operated in accordance with Hemisphere GNSS' relevant User’s Manual and
Specifications, AND the Product is not modified or misused. NO OTHER REMEDY (INCLUDING, BUT NOT LIMITED TO,
SPECIAL, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR CONTINGENT DAMAGES FOR LOST PROFITS, LOST SALES
INJURY TO PERSON OR PROPERTY, OR ANY OTHER INCIDENTAL OR CONSEQUENTIAL LOSS) SHALL BE AVAILABLE TO
PURCHASER, even if Hemisphere GNSS has been advised of the possibility of such damages. Without limiting the
foregoing, Hemisphere GNSS shall not be liable for any damages of any kind resulting from installation, use, quality,
performance or accuracy of any Product.

HEMISPHERE IS NOT RESPONSIBLE FOR PURCHASER’S NEGLIGENCE OR UNAUTHORIZED USES OF THE
PRODUCT. IN NO EVENT SHALL HEMISPHERE GNSS BE IN ANY WAY RESPONSIBLE FOR ANY DAMAGES RESULTING
FROM PURCHASER’S OWN NEGLIGENCE, OR FROM OPERATION OF THE PRODUCT IN ANY WAY OTHER THAN AS
SPECIFIED IN HEMISPHERE GNSS’ RELEVANT USER’S MANUAL AND SPECIFICATIONS. Hemisphere GNSS is NOT
RESPONSIBLE for defects or performance problems resulting from (1) misuse, abuse, improper installation, neglect of
Product; (2) the utilization of the Product with hardware or software products, information, data, systems, interfaces or
devices not made, supplied or specified by Hemisphere GNSS; (3) the operation of the Product under any specification
other than, or in addition to, the specifications set forth in Hemisphere GNSS’ relevant User’s Manual and Specifications;
(4) damage caused by accident or natural events, such as lightning (or other electrical discharge) or fresh/salt water
immersion of Product; (5) damage occurring in transit; (6) normal wear and tear; or (7) the operation or failure of operation
of any satellite-based positioning system or differential correction service; or the availability or performance of any
satellite-based positioning signal or differential correction signal.

THE PURCHASER IS RESPONSIBLE FOR OPERATING THE VEHICLE SAFELY. The purchaser is solely responsible
for the safe operation of the vehicle used in connection with the Product, and for maintaining proper system control
settings. UNSAFE DRIVING OR SYSTEM CONTROL SETTINGS CAN RESULT IN PROPERTY DAMAGE, INJURY, OR DEATH.
The purchaser is solely responsible for his/her safety and for the safety of others. The purchaser is solely responsible for
maintaining control of the automated steering system at all times. THE PURCHASER IS SOLELY RESPONSIBLE FOR
ENSURING THE PRODUCT IS PROPERLY AND CORRECTLY INSTALLED, CONFIGURED, INTERFACED, MAINTAINED,
STORED, AND OPERATED IN ACCORDANCE WITH HEMISPHERE GNSS’ RELEVANT USER’S MANUAL AND
SPECIFICATIONS. Hemisphere GNSS does not warrant or guarantee the positioning and navigation precision or accuracy
obtained when using Products. Products are not intended for primary navigation or for use in safety of life applications.
The potential accuracy of Products as stated in Hemisphere GNSS literature and/or Product specifications serves to
provide only an estimate of achievable accuracy based on performance specifications provided by the satellite service
operator (i.e. US Department of Defense in the case of GNSS) and differential correction service provider. Hemisphere
GNSS reserves the right to modify Products without any obligation to notify, supply or install any improvements or
alterations to existing Products.

GOVERNING LAW. This agreement and any disputes relating to, concerning or based upon the Product shall be
governed by and interpreted in accordance with the laws of the State of Arizona.

OBTAINING WARRANTY SERVICE. In order to obtain warranty service, the end purchaser must bring the Product to a
Hemisphere GNSS approved service center along with the end purchaser's proof of purchase. Hemisphere GNSS does not
warrant claims asserted after the end of the warranty period. For any questions regarding warranty service or to obtain
information regarding the location of any of Hemisphere GNSS approved service center, contact Hemisphere GNSS at the
following address:

Hemisphere GNSS

8444 N. 90th Street, Suite 120
Scottsdale, AZ 85258

Phone: 480-348-9919 Fax: 480-348-6370
techsupport@hemispheregps.com
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